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Declaration of Conformity

Standards to which Conformity is declared: FCC Part 15

This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions:

(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Responsible Party’s name: Hughes Network Systems, Inc.

Address: 11717 Exploration Lane, Germantown, MD 20876

Telephone: 866-DIRECWAY (347-3292)

Trade Name: HUGHES

Type of Equipment:Satellite Transmit and Receive Modem, VSAT, Ethernet Appliance

Model Numbers:DW4-G1

Part Numbers: 3003618
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For your safety and protection, read this entire manual before you 
attempt to install the DW4020. In particular, read this safety 
section carefully. Keep this safety information where you can 
refer to it if necessary.
Types of warnings used 
in this manual

T
m

his section introduces the various types of warnings used in this 
anual to alert you to possible safety hazards.
DANGER

Indicates an imminently hazardous situation, which, if not 
avoided, will result in death or serious injury.

WARNING

Indicates a potentially hazardous situation, which, if not 
avoided, could result in death or serious injury.

CAUTION

Indicates a potentially hazardous situation, which, if not 
avoided, may result in minor or moderate injury.

CAUTION
Indicates a situation or practice that might result in property 
damage.
 • Important safety information
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About this document
Scope and audience T
Download from 
his manual describes installing and servicing the DIRECWAY® 
DW4020 terminal. It addresses installers, network system 
engineers, and network operators who install, commission, 
operate, and maintain the system. 
Audience profile T
i

he DW4020 is installed by professional telecommunications 
nstallers. This product cannot be installed by the end user.

There are four primary audiences:

• HNS Installers – at this time, only HNS installers will install 
this product.

• Installer trainers, who prepare separate instructions for the 
installers. 

• Call center operators, who respond to user’s calls. 
• Call center trainers, who train call center operators. 
Organization and 
updates

T
c

his manual is organized into the following chapters.  Major 
hanges from Revision 1 are identified.

Chapter 1 - Introduction gives an overview of the DW4020 and its 
components.  The description of IP addressing is moved to an 
appendix. 

Chapter 2 - Installing the indoor equipment provides information 
regarding installing and configuring the DW4020. The "modem" 
method using Websetup is documented.  The "manual" method 
using the serial port is moved to an appendix.  

Chapter 3 - The User Interface provides information about the 
new browser-based interface.  The interface reports performance 
data and information for configuring operating systems network 
settings.

Chapter 4 - DW4020 LEDs and troubleshooting described LED 
activity and troubleshooting stratetgies.

There is also a safety summary, glossary, list of abbreviations and 
acronyms, appendices, and index.
 • About this document
1031484-0001 Revision 2 xi

Www.Somanuals.com. All Manuals Search And Download.



xii
Conventions T
t

 • About this document
1031484-0001 Revision 2

Download from 
his manual follows the typographical conventions shown below 
o help clarify instructions:

Example Explanation

Click Exit. Indicates the names of command 
buttons that execute an action.

The system displays the following: 
Are you ready?

Indicates all system messages 
and prompts as the system 
displays them.

Type exit Indicates operator input.

Enter a value in the Time field. Indicates the names of fields on 
windows.

Retrieve the following file:
O:\template\techman_r3

Indicates file names or file paths 
referenced in the manual.

Press ALT+V to view the menu. Indicates function or keyboard 
keys. Press two keys 
simultaneously—in this case, Alt 
and V.

Select the Edit menu. Indicates the names of menu bar 
options on a software screen.

Go to Edit → Spelling Checker Indicates a menu/submenu 
sequence for selecting an action 
or option
Related publications T
t

he installation of this product may also require the use of one of 
he following antenna or outdoor unit manuals:

• DIRECWAY Satellite Dish Installation Guide Model: 
DW4000 Two-Way (HNS 1031362-0201)

• DIRECWAY Outdoor Unit Installation Guide DW 4000-098 
DW 4000-120 (HNS 1032025-0001)

• .89/.98M Ku-Band Rx/Tx Series 1892/1982 Antenna System 
Assembly Manual (Prodelin 4906-629)

• 1.2m Ku-Band Rx/Tx Series 1132 Antenna System 
(Prodelin 4906-630)
Revision record
Revision Date of issue Scope

Rev 1 8/02/02 Production release

Rev 2 9/27/02 Incorporates Web commissioning

Rev 3 10/24/02 Documents change to Websetup 
Welcome screen
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Chapter 1
Introduction
This chapter addresses the following topics:

• DW4020 purpose and components on page 1
• Characteristics and identification of equipment on page 2
DW4020 purpose and 
components

T
c

he DW4020 is designed to provide multiple computer 
onnections through a single DIRECWAY® terminal. It is 

composed of three stackable components as shown in Figure 1:

• Receive modem (also sometimes referred to as the Indoor 
Receive Unit (IRU))

• Transmit modem (also sometimes referred to as the Indoor 
Transmit Unit (ITU))

• Gateway (GWH)
Note: Revision 1 of this manual referred to the DW4020 as the 
"Gateway," and the Gateway as the "Gateway host." This 
terminology has changed. Please use the terminology in this 
manual.

Figure 1: The DW4020

Receive modem

Transmit modem

Gateway
Chapter 1 • Introduction
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These units, in combination with an antenna, provide satellite 
connectivity for multiple local area network (LAN) hosts through 
one DIRECWAY System. All the necessary software resides on 
the Gateway, which serves as the router. Because the software is 
on the Gateway, there is no need for a computer to run client 
software, unlike previous versions of DIRECWAY.

Figure 1 illustrates the functionality of the DW4020 within a 
DIRECWAY network. Note that the DW4020 is independent of 
operating platforms. It can also be used with devices other than 
computers, such as point-of-sale (POS) terminals or credit 
verification devices.
Figure 2: Remote site with DW4020 installed
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Characteristics and 
identification of 
equipment 

T

T

T

he part number label is located on the rear of the unit.

able 1 shows the hardware characteristics of the DW4020.

able 2 shows the physical characteristics of the unit.

Table 3 shows the cable requirements for the unit. The cable 
requirements are the same regardless of the type of antenna used.
Www.Somanuals.com. All Manuals Search And Download.
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Table 1: DW4020 hardware characteristics

Characteristic DW4020

Main processor 200Mhz

Ethernet 10/100 4 ports (switched) 
RJ-45

Main Memory 32MB

Flash Memory 8MB

Serial Port Asynchronous RS232

USB Port One USB 1.1 (Type A) 

Table 2: DW4020 physical characteristics 

Characteristic Value

Physical Dimensions
Height
Width
Depth
Weight

5.75 inches
6.5 inches
8.8 inches
4.0 lbs.

Electrical Requirements
Input line voltage
Input line frequency
Current Required

90 - 264 V ~ 2A max, 
50-60 HZ AC
100 W typical
Chapter 1 • Introduction
1031484-0001 Revision 2 3
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Table 3: Cable requirements

Grounding and Cable Choice

Your choice of grounding scheme may affect your choice of cable. Note that meeting the 
National Electrical Code grounding requirements is easier if you use RG-6 with quad shield. 
However, you can also use standard RG-6 and ground according to the Code or the 
instructions in the antenna installation manual.

Recommended cable specifications for One-Way and Two-Way Systems

Cable length from satellite 
dish to DW4020

Type of cable to be used 

Receive Transmit

Up to 300 ft. RG6 with solid copper 
center conductor 
(CommScope 5729 or 
equivalent)

RG6 with solid copper 
center conductor 
(CommScope 5729 or 
equivalent)

300 ft. to 420 ft. RG6 with solid copper 
center conductor 
(CommScope 5729 or 
equivalent)

RG6 with solid copper 
center conductor and quad 
shield (CommScope 5781 
or equivalent)

Important: A higher grade of cable can be used for an installation where a lower grade is 
specified. For example, an RG6 cable with solid copper center conductor and quad shield 
can be used for installations where the cable length is less than 300 ft. Never use a lower 
grade of cable than specified. Be sure to record the grade of the cable used for your 
installation. The grade is printed on the cable every few feet. Never use a cable which 
does not have the manufacturers name and its grade clearly printed on it!
Important notes:

1.  Coaxial cables with copper clad steel center conductor are 
not recommended.

2. Do not use splitters.
3. Line amplifiers are required for Receive cable runs of more 

than 150 ft.
4. If the Receive cable run length is less that 150 ft., then no line 

amplifier is required. If the Receive cable run length is 
greater than 150 ft., but less than 300 ft., then install a a line 
amplifier in the Receive cable only, at a minimum of 25 ft. 
and up to 30 ft. from the LNB.

5. A line amplifier can only be installed in the Receive cable, 
not in the Transmit cable.

6. Line amplifier specification: Channel Master 5113 IFD or 
equivalent.
Www.Somanuals.com. All Manuals Search And Download.
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Chapter 2
Installing the indoor equipment
System pre-installation T
G

ogether, the receive modem, the transmit modem, and the 
ateway are called the DW4020 and sometimes referred to as the 

indoor unit (IDU). The receive modem is also called the IRU; the 
transmit modem is also called the ITU; and the Gateway is 
sometimes called the GWH. 

The three units must be stacked correctly to ensure proper heat 
dissipation. The receive modem must be installed on top of the 
transmit modem, which is in turn installed on top of the Gateway. 
See Figure 10 on page 15.
Installation PC requirements T
he installer laptop PC must fulfill the following requirements:

• USB port
• Ethernet
• Dial-out modem
• Windows 98 or higher, with DHCP configured to 

automatically accept IP addresses. See Appendix D.
• Websetup installed. See Installing DIRECWAY installation 

software on installer laptop on page 8.
Customer installation
requirements

T
he customer must have:

• A functioning Ethernet interface installed on at least one 
computer. This is not necessary to commission the DW4020, 
but you must ensure the customer can surf before you leave.

• Ethernet cables; as many as there are computers that will 
connect to the DW4020.

• An analog phone line.
Chapter 2 • Installing the indoor equipment
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Two DW4020 installation
methods

T

Chapter 2 • Installing the indoor eq
1031484-0001 Revision 2
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here two ways to install the DW4020.

• If an analog phone line is available, assemble and install the 
system using the instructions in Installing the system using a 
modem on page 11. This method is preferred and is usually 
the one that will be used.

• If no analog phone line is available, you must configure the 
DW4020 through the serial port. Follow the instructions in 
Appendix C.
Summary of DW4020
installation process

D
W4020 installation is a 10-step process.

1. Assemble the DW 4020 components.
2. Connect the DW4020 to the installer PC Ethernet and power 

up the DW4020. Use surge protectors.
3. Connect the installer PC via USB and run Websetup to 

establish operating parameters and commission.
4. Register the customer and select subscription options via 

Websetup.
5. Record site ID and assigned IP address(es) for the customer 

on the cover of the User Guide.
6. Transfer of parameter information to Gateway Host; Exit 

Websetup.
7. Assemble and install the satellite antenna. Run cables from 

the outdoor components to the indoor equipment. Clearly 
label the receive and transmit coaxial cable at the antenna, 
ground block, and indoor units connectors.

8. Complete pointing and ACP.
9. Disconnect installer PC and connect the Gateway to the 

receive modem with the USB cable. Connect the customer 
computer equipment to the Gateway via Ethernet cable. 

10. Verify customer operation, information recorded on User 
Guide cover, and receive and transmit cable labeling. 
Optional: assist in customer computer configuration.
Antenna installation T
T

he DW4020 can be used with the HNS DW4000 74cm 
wo-Way antenna. The DW4020 can also be used in conjunction 

with 98cm, 1.2m, and 1.8m antennas. Refer to the manufacturer’s 
antenna installation manual for instructions on how to install the 
antenna. See the About section for a list of antenna installation 
manuals. Follow all safety procedures. Cable requirements are on 
page 4.
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CAUTION
A password from the authorized installer is required before 
the National Operations Center will activate the system.

CAUTION
Professional installation and service of the antenna 
assembly is required by the Federal Communications 
Commission because the radio transmits radio frequency 
energy.

• The two-way antenna assembly must be installed in a 
location or manner not readily accessible to children.

• The two-way antenna assembly must be installed at 
least 5 feet (1.5 meters) above ground level or any 
nearby surface on which a person could sit or stand.

CAUTION
• The two-way satellite dish assembly emits radio 

frequency energy when in the transmit mode.
• Unplug indoor power connection before performing 

maintenance or adding upgrades to any satellite dish 
components.

• To avoid risk of injury, do not place head or other body 
parts between feed horn and reflector when system is 
operational.

�����0���&�����
������������������
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Installing DIRECWAY 
installation software on 
installer laptop

T
s
n
i

Chapter 2 • Installing the indoor eq
1031484-0001 Revision 2

Download from 
he installation software for the DW4020 is on a CD. The 
oftware will enable you to register DW4020 customers. You 
eed a receive modem (IRU) to install the software on your 
nstaller laptop PC. 

Do not confuse the installation software with the software that is 
downloaded to the Gateway via satellite during registration. The 
DW4020 installation software enables you to register customers 
and configure the DW4020 for operation. The software that 
actually operates the DW4020 is downloaded during registration.

It is important to understand that there are three service options: 
consumer, small office/home office, and enterprise. Each option 
has its own registration server that appears in the Websetup 
Welcome screen when you start Websetup to register a customer. 
You must be careful to choose the correct option.  If in doubt 
consult the work order. 

For example, if you are installing a DW4020 for a SOHO 
customer, you would double-click on the registration server for a 
SOHO installation. If you click on one of the other servers, you 
will not be able to install the customer correctly.
uipment
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 Installing the software D
Y

Download from 
o not connect USB cable to the receive modem until prompted. 
ou may use the cable that came with the unit, or a different cable 

if you need a longer one. 

1. Load the installer software CD into your laptop computer. 
The installation wizard should appear. If it does not, select 
Start→Run, browse to the CD drive, select it, and select 
setup.exe.

2. Select Install Software. A Setup screen appears.
3. Select Next. An Agreement screen appears.
4. Select Yes. The Device Install Status screen in Figure 4 

appears. 
5. Connect the USB cable. The installation will complete and 

the Websetup Welcome screen appear. See Figure 5. If you 
are prompted for the location of your Windows .cab files, 
enter the location or insert your Windows installation CD, 
load the files, and re-insert the DIRECWAY installation CD.
 If you continue to see the Device Install Status screen, try the 
following:

– Unplug the USB cable and plug it in again.
– Verify you are using the correct power supply.
– Try a different cable.
– Troubleshoot your USB port.
–  Try a different receive modem.

6. Select Exit.

Figure 3: Installation screen
Note: If you are using Windows XP as the installer laptop 
operating system, the laptop may reboot after you attach the 
USB cable. If this occurs, unplug the USB cable and repeat 
the installation process after the laptop reboots.
Chapter 2 • Installing the indoor equipment
1031484-0001 Revision 2 9
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Figure 4: Device Installation Status

Figure 5: Websetup Welcome screen
uipment
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Installing the system 
using a modem

Y
m

Download from 
ou need all the items shown in Figure 6. Some of them are in the 
odem installation kit or inside the antenna box. 

If you are using Web commissioning, you must provide an 
Ethernet cable to connect between the DW4020 and installer PC. 

If Web commissioning is not available, you must provide a 9-pin 
female/female (F/F) null modem serial cable. The serial cable can 
be used to configure the DW4020 via the serial port. Appendix C 
– Installing the DW4020 Manually, on page 77. 

You will also need the installation work order. This is provided to 
you by HNS.   
Note: At some installation sites, the USB cable that comes with 
the DW4020 may not be long enough to reach from the installer 
PC to the DW4020. You may need a long USB cable.

Figure 6: Items required for installation
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The power supply T
1

Chapter 2 • Installing the indoor eq
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Download from 
he DW4020 uses a power supply with the part number P/N: 
031105-0001. The part number is on a sticker on the power 

supply. Verify that you are using the correct power supply. Do not 
use anything but the power supply supplied with the DW4020 
system (1031105-0001). 

Be sure the power supply is labeled ADP 64AB B in the upper 
right hand corner of the label, above the bar codes. See Figure 7.

 

CAUTION
• This unit’s performance may suffer if the wrong power 

supply is used.
• This unit must be used with the power supply PN 

1031105-0001.
• When power needs to be removed from the receive 

modem, ALWAYS unplug the AC power cord from either 
the wall outlet, surge protector, or power strip.

• NEVER pull the power cord from the back of the receive 
modem. Doing so could damage the pins and also 
cause a short in the system.

• Power supply with the part number 1031105-0001 is to 
be used only in the United States and Canada.

• This unit must be used with 110-volt AC input.
• Other countries may have different standards and 

requirements.
Figure 7: ADP-64AB B above bar code

ADP-64AB BPN: 1031105-0001 
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Assembling the
components, modem

installation method

F
t
s
c

Download from 
ollow the steps below and refer to the illustrations on page 13 
hrough page 16 to assemble the DW4020 components. Note that 
ome cables are connected to the installer laptop until 
ommissioning is complete. Then the DW4020 is connected to 

the customer’s computer.

Before beginning the installation, be sure that you have installed 
the installation software correctly. See Installing the software on 
page 9. In addition, confirm that DHCP is enabled to accept IP 
addresses automatically on your installer laptop PC. See 
Appendix D –  on page 113.
CAUTION
• The components must be stacked in this order: Gateway 

on bottom; transmit modem on top of Gateway; receive 
modem on top of transmit modem. See Figure 10.

• If the components are not stacked in the proper order, the 
receive modem may overheat and malfunction.

• Do not block any ventilation openings. Do not install near 
any heat sources such as radiators, heat registers, 
ovens, stoves, or other apparatus (including amplifiers) 
that produce heat.

• Recommended ventilation space around the top and 
sides of the DW4020 assembly should be approximately 6 
inches. Ventilation is necessary to avoid overheating.
1. Be sure the power supply is not plugged into a wall outlet, 
surge protector, or power strip.

2. Lay two of the four clips on a table and mount the 
components as shown in Figure 8. Mount the Gateway first, 
then the transmit modem, then the receive modem.

3. Turn the component stack right side up and install the other 
two clips as shown in Figure 9.
Note: The Gateway and the transmit modem have a hole at 
the center of each of their four feet. There is a tab on the 
bottom of each mounting clip, which snaps into place on the 
Gateway when properly aligned over the hole.There is also a 
tab in the middle of each mounting clip, which snaps into place 
on the transmit modem when properly aligned over the hole.
4. Double-check that the components are installed in this order 
from top to bottom: receive modem, transmit modem, 
Gateway. See Figure 10.
Chapter 2 • Installing the indoor equipment
1031484-0001 Revision 2 13
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Figure 8: Mount the components on two clips

Figure 9: Attach the other clips
Chapter 2 • Installing the indoor equipment
1031484-0001 Revision 2
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Figure 10: Component stack

Receive modem

Transmit modem

Gateway
Chapter 2 • Installing the indoor equipment
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5. Connect the component interconnection cables. See 
Figure 11. A USB cable connects the receive modem and the 
installer PC; you may use a longer cable rather than the one 
that is supplied if you wish. An Ethernet cable connects the 
Gateway and the installer PC. A 25-pin connector cable 
connects the transmit and receive modems. A power supply 
adapter cable provides power to the Gateway and receive 
modem. See Figure 11. 

6. Attach the power supply cords to the power supply and to the 
power adapter. Ensure that the power cord is tightly 
connected to the power supply, receive modem, and Gateway. 
See Figure 12.

Figure 11: Attach interconnection cables
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Figure 12: Connect power cord
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Connect Ethernet, 
power up, and read the 
Gateway LED display

A
w
o
c

fter you assemble the DW4020, connect it to the installer laptop 
ith Ethernet cable. Plug it into a 110 V wall outlet, power strip, 
r surge protector. The Gateway LED display will cycle. The 
ycle completes in less than a minute and follows this sequence:

• Gateway STATUS LED is red until the power-on self-tests 
are completed.

• Gateway READY LED blinks green because it is not yet 
commissioned.

• Gateway STATUS LED blinks orange as it is not attached to 
the receive modem.
Note: In countries outside North America, the DW4020 may be 
plugged, with a physical adapter, directly into a 220 V outlet. 
Different countries may have different standards and requirements. 

Note: Whenever the LEDs do not function properly as described 
below, check to be sure you have the correct power supply, PN 
1031105-0001.
Chapter 2 • Installing the indoor equipment
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The transmit and receive modems have their own LEDs, which 
show their status. These are described in The modems’ LEDs on 
page 18.

For more information on LEDs, troubleshooting, and LED 
blinking and status codes, see Chapter 4 – DW4020 LEDs and 
troubleshooting, on page 53.

Note that normal Gateway operation alone doesn't imply normal 
DW4020 operation. The installation and commissioning process 
may not have been completed or software download (DLL) from 
the Network Operations Center (NOC) may not have been 
completed. Additional status information is available via the User 
Interface. See Chapter 3 – The User Interface, on page 33) and 
the LEDs on the receive and transmit modems. The modems’ 
LEDs.

Table 4: Gateway LED display

LED condition STATUS LED READY LED

Off Power off Power off or startup 
diagnostics not yet run 
successfully

Steady Green Normal operation Running software 
downloaded from NOC; 
successfully 
commissioned

Blinking Orange Contact between GWH 
and IRU over USB not 
established; USB cable 
not installed or some 
other USB problem

Not applicable

Blinking Green Not applicable Not commissioned

Steady Red Power on tests Not applicable
Obtain IP address and test
Ethernet connection
1. Restart the PC so that the Gateway assigns it an IP address. 
Or use the command ipconfig /renew from a DOS 
command line prompt.

2. The embedded DHCP server assigns IP address = 
192.168.0.2 to the PC. The DW4020 Address is set to 
192.168.0.1. 

3. Make sure the PC can communicate with the DW4020 over 
the Ethernet connection. Enter Ping <192.168.0.1> at a 
DOS prompt.
The modems’ LEDs T
p

he receive and transmit modems have LEDs on their front 
anels. Both modems have a green READY LED. The receive 

modem has a green RX LED. The transmit modem has a green 
uipment
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TX LED. The LEDs’ status indicate various conditions. Table 5 
describes the basic states.

The LEDs may also indicate various conditions through blink 
patterns. The numbers in brackets are the status codes discussed 
in The System Status indicator on page 36. 

If the modem does not appear to be functioning, check all cable 
connections. If they are secure, cycle the power by unplugging 
the power cord at the power supply and plugging it back in. A 
number of conditions and corrective actions are described in 
Chapter 4 – DW4020 LEDs and troubleshooting, on page 53.

The READY LEDs should come on steady when the DW4020 is 
powered up, commissioned, and when it is operating. The TX and 
RX lights can also blink when the DW4020 is first powered up, or 
when the DW4020 is power cycled. However, that blinking does 
not indicate anything about their status.
Table 5: Basic Receive and Transmit Modem LED States

Ready OFF/RX OFF Ready ON/RX Off Ready ON/RX 
blinking

Receive modem Modem not functioning Modem functioning, no 
data being received

Modem functioning, 
data being received

Ready OFF/TX OFF Ready ON/TX Off Ready ON/TX blinking

Transmit modem Modem not functioning Modem functioning, no 
data being transmitted

Modem functioning, 
data being transmitted
The DW4020 is extremely reliable. If you find you cannot surf 
the Internet or the DW4020 seems to have a problem, follow this 
sequence of steps below to identify and fix the problem.

• Check whether the DW4020 LEDs are on or off. The LEDs 
may indicate that a connection has become loose. 
Reconnecting a cable or power cord may restore function. 

• Check if the LEDs are blinking in a pattern. The LEDs can 
blink in a pattern. The patterns correspond to the receive and 
transmit status codes discussed in Transmit Status messages 
on page 37 and Receive Status messages on page 42. See 
LED blinking indicating status codes on page 60 for a 
discussion of the blinking LEDs.

• Check if the LEDs on the back of the Gateway or on or off. 
The LAN ports on the back of the Gateway have LEDs. See 
Ethernet port LEDs on page 20.

• Contact technical support. If the corrective actions described 
in this chapter and Chapter 3 – The User Interface do not 
solve the problem, contact technical support.
Chapter 2 • Installing the indoor equipment
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Ethernet port LEDs E
a
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ach of the four Ethernet ports on the DW4020 has two LEDs 
ssociated with it. One LED is green and one is yellow. See 

Figure 13.

The green LED will be on if power is applied to the DW4020 and 
a 100baseT Ethernet device is connected to the corresponding 
Ethernet port. Otherwise, the green LED will be off.

If the power is on and the light is off while a network device is 
connected, then the device is a 10baseT device and the port is 
autosensing.

The yellow LED will also be on when power is applied to the 
DW4020. It will flash momentarily when there is LAN activity 
on the corresponding Ethernet port.
Figure 13: Ethernet port LEDs

Green LED Yellow LED
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Running the DW4020 
installation software, 
commissioning, and 
registering the 
customer

T
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Download from 
he DW4020 installer’s computer software is basically 
IRECWAY 4.0 software with some functions, such as 

nteracting with a browser, removed. It is used to run Websetup 
nd commission the customer. 

here are three registration servers, one each for consumer, small 
ffice/home office, and enterprise. Before you select the 

registration server, check the work order and confirm which 
service option the customer has chosen.

You will connect the installer laptop and receive modem, register 
the customer, peak the satellite signal, connect the customer’s 
DW4020, and confirm that they can surf the Internet.

1. Connect the receive modem to the installer laptop PC with 
the USB cable.

2.  Connect the installer laptop PC to an analog telephone line 
or alternate connection to the Internet.

3. Select Start→Programs→Direcway Installer→Websetup. The 
Welcome screen appears. Check the work order for the 
service option and highlight the proper registration server.  
The select Next. Follow the instructions on subsequent 
screens; the instructions below will supplement the onscreen 
instructions.
If the Welcome screen does not appear, the receive modem is 
not connected to the PC or there is a problem with the receive 
modem installation. Check cable connections. If cable 
connections are not the problem, restart the PC. If that does 
not solve the problem, call technical support.

Figure 14: Welcome screen; choose proper registration server
Chapter 2 • Installing the indoor equipment
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4. Websetup will first detect the Gateway and the modem. See 
Figure 15.

5. Then Websetup will check for an existing connection to 
WebACS. Websetup may bring up a dial-up connection if 
necessary. See Figure 16.

Figure 15: Websetup - Detection

Figure 16: Dial up connection may be necessary
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6. Websetup will then authenticate the receive modem serial 
number and enable it. See Figure 17.

7. Websetup then presents a series of forms to the user to 
complete registration. See Figure 18 through Figure 20. The 
appearance of the forms may vary, and the forms’ content 
may change from time to time. For example, a SOHO 
customer Service Offerings screen shown in Figure 19will be 
different from a consumer screen.

Figure 17: Registration Connection - Authentication

Figure 18: Agreement
Chapter 2 • Installing the indoor equipment
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Figure 19: Service Offerings

Figure 20: Registration
Note: The registration information in Figure 20 is very 
important. Make certain this information is recorded on 
the cover of the customer’s User Guide. That way the 
customer will have important information available 
should their DW4020 not function and they need to call 
technical support.
uipment
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8. After the customer enters registration information, write the 
information in Figure 20 on the cover of their User Guide.

9. Select Continue in the Registration screen in Figure 20. The 
Antenna Pointing - Antenna Location screen appears. See 
Figure 21.

10. Verify that the ZIP code shown matches the ZIP code for the 
installation site. If not, correct it. Select Next. The Antenna 
Pointing - Receiver screen appears. See Figure 22. At this 
point it shows no signal strength or auto cross-pol checkbox.

11. Click through all pointing screens by selecting Next. Click 
through until you reach the Websetup - Finish screen. You 
will finish registration before peaking the signal.

Figure 21: Enter ZIP code
Note: You must not disconnect the power cables before 
completing Step 13. Finish registration before peaking the signal.
12. When the Websetup-Finish screen appears, Websetup 
receives a parameter file from the WebACS and transfers it to 
the DW4020 over the Ethernet connection. If it is successful, 
a message appears asking you to press Finish. See Figure 23.

13. Select Finish. The unit is commissioned. A message may 
appear telling you to connect and reconnect the USB cable. 
Click OK. You do not need to do anything with the USB 
cable at this time.
Chapter 2 • Installing the indoor equipment
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Figure 22: Antenna Pointing - Receiver

Figure 23: Finish

Figure 24:
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Post-commissioning I
D

Download from 
n post-commissioning, you peak the satellite signal, attach the 
W4020 to the customer computer that has a functioning 

Ethernet interface, and confirm the customer can surf the Internet.
Peak the satellite signal
 1. Unplug the DW4020 power cord from the wall outlet or surge 
protector.

2. Remove the phone line and network cable from the installer 
laptop PC.

3. Remove the network cable from the Gateway and unplug the 
USB cable from the receive modem.

4. Connect a long USB cable from the back of the receive 
modem to the installer laptop PC.

5. Assemble and install the satellite antenna.
6. Place the outdoor pointing interface (OPI) in the receive 

cable line if applicable.
7. Power on the DW4020.Select Start→Programs→DIRECWAY 

Installer→Antenna Pointing. The Antenna Pointing - Antenna 
Location screen appears. See Figure 25.

8. Verify the ZIP code matches the antenna location and select 
Next. The Antenna Pointing - Receiver screen appears. Check 
the Longitude, Hemisphere, and Frequency values. See 
Figure 26.

Figure 25: Antenna Location; verify ZIP code
Chapter 2 • Installing the indoor equipment
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9. Use the Elevation, Azimuth and Polarization values to adjust 
the antenna to achieve maximum receive signal strength.

10. Select the ACP (auto cross-pol) checkbox. If it is not 
available, wait five minutes; the system will update.

11.  Select Next to go to the Antenna Pointing - Transmitter 
screen. See Figure 27.

 

Figure 26: Antenna Pointing - Receiver

Figure 27: Start manual cross-pol; pass and peak isolation
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12. Select the Manual fine pointing mode radio button. 
13. Select Start Test. Adjust the antenna to achieve maximum 

transmit isolation.
14. When the unit consistently passes the manual transmit test, 

bolt the antenna securely before going to Step 15.
15. After the antenna is bolted, select Stop Test. See Figure 28.
16. Then select the Automatic radio button and select Start Test 

to start the automatic ACP test. See Figure 29.
17. Make sure the test passes. 
18. Select Exit after passing the test.

Figure 28: Manual cross-pol passed; select Stop Test

Figure 29: Auto cross-pol
Chapter 2 • Installing the indoor equipment
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Figure 30: ACP passes; select Exit
Connect to customer
computer and confirm

surfing
1. Disconnect the USB cable from the installer’s PC.
2. Connect the receive modem to the Gateway using the USB 

cable supplied with the unit. See Figure 31.The DW4020 will 
re-initialize and come back up in normal mode. 

3. Connect the receive coaxial cable to the receive modem and 
the transmit coaxial cable to the transmit modem. See 
Figure 31.

4. Plug the power cord into the wall outlet or surge protector.
5. Make sure that the READY LEDs on all three units are 

STEADY GREEN. Make sure the transmit and receive cables 
are clearly labeled at the connectors.

6.  The DW4020 is now commissioned. Connect the customer’s 
computer and the Gateway with Ethernet cable. See 
Figure 31. If the computer has a functioning and properly 
configured Ethernet interface, it will surf the Internet. If the 
customer cannot surf, see the instructions below.
uipment
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f the customer cannot surf, configure your installer laptop so its 
etwork properties match the customer’s. Refer to Appendix D for 

exact instructions for setting your network properties. Then:

1. Start a Web browser on the installer laptop.
2. Enter the Gateway IP address in the browser URL location 

bar and press Enter. If the DW4020 is functioning, the User 
Interface appears.

3. Enter an URL for a known Web site, such as abc.com or 
cnn.com. If it appears, the DW4020 is functioning and any 
problem exists on the customers computer. The customer’s 
network properties may not be configured properly, or there 
may be some other system problem. They should consult the 
User Guide for support information.

Figure 31: Final cabling
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Chapter 3
The User Interface

In the Version 1.0 software, DW4020 status information was 
available on menus accessed through the serial port via 
Hyperterminal. In the Version 2.0 software, a browser-based User 
Interface provides information about system status, system 
configuration, online documentation, and firewall configuration. 
Access it if the DW4020 doesn’t seem to be functioning properly, 
to find system information for configuring networks, or to check 
system performance. Clicking on items highlighted in blue 
displays help information or other documentation.
Note: The information about the DW4020 User Interface in this 
manual is the same as that in the DW4020 User Guide (HNS 
1032564-0001 Rev A). Each DW4020’s software is updated 
periodically via satellite link. The updates should be reflected in 
User Interface Help if they are not documented in the User Guide 
or in this manual. Always refer to User Interface Help and the 
latest revision of the User Guide, as well as this manual, for the 
latest information about the User Interface and DW4020 software.
If at any time you are unable to access the User Interface, take the 
steps below:

• Make sure the Gateway is powered up. The STATUS and 
READY LEDs should be lit continuously. If they are not, 
power cycle the DW4020 by unplugging the power cord from 
the wall outlet or surge protector, waiting 10 seconds, and 
plugging it back in. Refer to the Chapter 5 Troubleshooting 
for more information.

• If the User Interface is still not accessible, check the Ethernet 
cable connection from the computer to the DW4020. Check 
that the power adapter is securely attached to the receive 
modem and Gateway. Also check the computer’s network 
configuration.

• If the User Interface is still not available, contact technical 
support.
Chapter 3 • The User Interface
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he User Interface is accessed through any browser, such as 
nternet Explorer or Netscape. Follow the steps below to set up an 
ntry for the User Interface in a browser. The steps are written for 

Internet Explorer or Netscape, but you can use a similar 
procedure for any browser.

1. Go to Start→Programs→Internet Explorer (or Netscape). The 
browser interface appears.

2. Place the cursor in the Internet Explorer Address bar or the 
Netscape Location Bar.

3. Type the DW4020 IP Gateway address. The should have been 
written this on the front of this manual when the installer 
finished configuring the unit.

4. Press ENTER. The User Interface Home screen appears. See 
Figure 32. . 
Figure 32: The User Interface Home screen
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Download from 
he Home screen has system indicators across the top. There are 
enu items in a column along the left. The system indicators 

consist of the following:

• System Status reports the strength of the receive signal, the 
status of the receive and transmit modems, and software 
download status. If System Status is colored green, the 
DW4020 is functioning properly. If there is a problem, it is 
colored red and the word “PROBLEM” appears below 
System Status. See Figure 33.

• Receive Statistics reports data on receive modem 
functioning.

• Transmit Statistics reports data on transmit modem 
functioning.

• System Information provides information such as the 
Gateway IP address, subnet mask, site ID, and what features 
are enabled.
Figure 33: System Status reports PROBLEM
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licking on System Status will display a System Status screen. 
See Figure 34.
Figure 34: System Status screen
The screen consists of the following fields.

• Signal Strength - indicates the signal quality factor (SQF), 
which is the strength of the receive signal. If SQF is 30 or 
below, the antenna must be repointed by a certified 
professional installer.

• Transmit Status - indicates the status of the transmit modem.
• Receive Status - indicates the status of the receive modem.
• Software Download Status - indicates the status of the 

downloading of software from the Network Operations 
Center (NOC). If the DW4020 has been commissioned, this 
message will generally indicate that software download has 
been completed. Occasional updates are automatically 
downloaded to the DW4020 from the NOC. The purpose of 
these updates is to enhance DW4020 performance. 
Remember that this software is not placed on the customer’s 
computer, but on the DW4020. No action is required from 
them. The software version number in the System 
Information page indicates the current version of the 
downloaded software. See System Information on page 45.
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If there is a problem with any of these four status elements, a red 
exclamation mark will appear in the status field. In addition, if 
there is a problem with the Transmit Status or Receive Status, an 
error message and an error code will appear in blue. You can click 
on the error message and an explanation of the error condition 
and what action might solve it will appear. See Figure 35. The 
tables below provide a more detailed explanation of status codes, 
error messages, and corrective actions.
Figure 35: On-line help for status messages
Transmit Status messages T
he following messages may appear in the Transmit Status field. 
The Comments section gives more information about each code, 
and describes any possible corrective measures. See Figure 36 on 
page 41 for corrective measure involving cables or the power 
supply. Power cycling means to unplug the power cord from the 
wall outlet or surge protector, wait 10 seconds, and plug it back 
in.
Chapter 3 • The User Interface
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Download from 
If corrective measures do not solve a problem, contact technical 
support.

TxCode 8 means the transmit modem is working properly. It is 
the code you will see most of the time.

Note: Remember that IRU refers to the receive modem, and that 
ITU refers to the transmit modem.
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Table 6: Transmit status (TxCode) messages and corrective actions

meric 
Code

Message Displayed Comments

The transmitter is not 
connected to the receiver

This status will occur only if the Indoor Transmit Unit (ITU) is not connected to 
the Indoor Receive Unit (IRU). It can result for the following reasons:

• The 25-pin parallel cable is not properly connected to the Indoor Receive Un
or Indoor Transmit Unit: Check the cable and make sure the ends are secure
fastened.

• Indoor Transmit Unit failure. The Indoor Transmit Unit has failed and may nee
to be replaced.

The transmitter has been 
disabled by the Network 
Operations Center

This condition occurs when the transmitter is not enabled. A transmitter may b
disabled for short periods of time by the NOC for service or troubleshooting. It 
may also be disabled if the user discontinues the satellite service. If this 
condition persists, it can only be corrected by requesting that the unit be 
enabled.

The transmitter has been 
placed in test mode by the 
Network Operations Center 

This status requires no user action and this test usually completes in 15 minute
or less. This condition occurs when the NOC places the transmitter into specia
transmission modes to measure the performance of the transmitter. When in th
mode, the unit is unable to transmit normal user data to the NOC.

The transmitter is locking to 
the receive carrier

This condition occurs during initial startup or when the receiver is locking to the
receive signal. It is normal for this condition to persist for up to 10 seconds. If th
condition
persists for more than 10 seconds, try disconnecting and reconnecting the 
receiver coaxial cable and wait 10 seconds. If the situation still persists, then th
Indoor Transmit Unit may need to be replaced.

The transmitter is not 
responding to commands sent 
from the receiver

This condition indicates that something is not operating properly in the 
Receive/Transmit Unit configuration. Perform the following actions to attempt to
recover from this condition:

• Verify that the Indoor Receive and Transmit Units are securely connected wit
a 25-pin parallel cable.

• Reset the IRU by unplugging the IRU power cord from the wall socket and the
plugging the power cord back into the wall socket. This will reset the Indoor 
Receive and Transmit Units.

This condition could also be caused if the power supply is faulty. If this conditio
cannot be resolved by following the steps listed above, then you may need to 
replace the power supply, the Receive/Transmit unit cable and/or the Transmit 
Unit.
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The transmitter is not locked to 
the network timing

No action is necessary if this condition occurs from time to time and quickly 
resolves itself. If this issue persists, it is likely due to a NOC-related service 
issue. The condition may also be due to Indoor Transmit Unit failure; in rare 
cases, the Transmit unit may fail and may have to be replaced.

The transmitter is not available 
because the receiver is not 
detecting a signal or is not 
locked to the correct 
network

Check your receive signal. This condition occurs when the Indoor Receive Unit 
not receiving a good signal. The receiver must be locked to the correct networ
in order for the transmitter to operate. If the receiver is not locked (no signal) or 
locked to the wrong network, the transmitter is unable to transmit data. Please
verify that you have a good signal strength by going to the Receive Statistics 
page. This could also be caused by inclement weather.

The transmitter is not available 
because the satellite receiver 
is not tuned for normal 
operation

This condition occurs when the transmitter is disabled for safety reasons. If this
happens during installation or commissioning, the installer will close the Antenn
Pointing program and resolve the condition.

The transmitter is available This is the normal operational state and indicates that the transmitter is ready t
transmit data.

The transmitter is adjusting for 
optimal network timing

This condition typically occurs when the DW4020 is first commissioned or the 
first time it is used for data traffic. This must occur before the Indoor Transmit 
Unit is able to transmit successfully. Typically, this process usually takes less 
than a minute.

The transmitter is unable to 
communicate with the Network 
Operations Center 

This condition indicates that the unit has stopped attempting to transmit user 
data because there were a number of failures in sending data to the NOC over
the satellite link. This could be the result of weather conditions causing lost 
packets or return channel equipment failures in the NOC.

The transmitter is not available 
because the receiver software 
is out of date

This condition indicates that the installed software version is not recent enough
to operate on the network. New software will be required from time to time due t
network infrastructure and capability upgrades and in order to maintain networ
efficiency and fix any known problems.The system will automatically update th
software version to ensure that you can enjoy uninterrupted operation. If you d
not use the DW4020 for a long period of time and miss the updates, you may 
need to contact Customer Care.

The transmitter is not 
receiving network control 
messages from the Network 
Operations Center 

This condition indicates a NOC equipment outage. This may be a transient 
condition and the system should recover automatically.

The transmitter is unable to 
range because it cannot 
communicate with the 
Network Operations Center

Ranging is the process that adjusts the satellite transmitter timing and 
power. The satellite transmitter conducts ranging as needed to ensure
that it can communicate successfully with the Network Operations 
Center.This condition can indicate any of the following:
• The NOC is not receiving ranging information from the transmitter. This may 

indicate a transmit problem at the NOC. This should get cleared in a few 
minutes.

• The transmitter is unable to achieve enough transmit power to send ranging 
information to the NOC. Make sure that the power supply is correct. The powe
supply should be Part #1031105-0001.

• The transmitter is sending incorrect timing data because the wrong zip code o
latitude/longitude information was entered during installation.

• The outdoor transmitter unit (ODU)--that is, the antenna--is not operating 
properly or is not properly connected to the ITU. Please ensure that the 
transmit cable is securely fastened to the Transmit Unit.

Table 6: Transmit status (TxCode) messages and corrective actions
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The transmitter is not available 
because ranging has failed

This condition indicates that the transmitter is not operational because ranging
has failed. Ranging is the process that adjusts the satellite transmitter timing an
power. The satellite transmitter conducts ranging as needed to ensure that it ca
communicate successfully with the Network Operations Center. The ranging 
failure may happen due to the antenna becoming misaligned or if repeated 
attempts to range do not succeed. This condition may also be caused due to 
adverse weather conditions. In rare cases, this may also indicate NOC issues 
but should clear within a few minutes.If the system was operational in the past
and you see these messages repeatedly, you can try to force range by 
performing the Connectivity Test.

The transmitter is waiting for a 
ranging request to be 
processed by the Network 
Operations Center

This condition occurs if the system is busy adjusting power and timing for othe
users. This process may take up to a minute or more.

The transmitter is waiting for a 
transmit request to be 
processed by the Network 
Operations Center

This condition occurs when the system is unable to provide transmit bandwidth
This occurs when many users sign-on simultaneously. It should clear in a few 
minutes automatically.

The satellite transmitter is 
unable to obtain an available 
transmission rate

This condition occurs if the transmitter cannot successfully range. Ranging is th
process that adjusts the satellite transmitter timing and power. The satellite 
transmitter conducts ranging as needed to ensure that it can communicate 
successfully with the Network Operation Center. A possible cause is that the 
transmitter could not achieve enough power to transmit. This is likely caused 
because the antenna is not accurately pointed. However, it may also be a 
transmitter power problem. Check the power supply and make sure that it is Pa
# 1031105-0001.

The transmitter is requesting a 
transmit pointing test

This condition can occur during installation when the Antenna Pointing program
on the installation computer requests that the transmitter perform a transmit 
pointing test. This condition persists until the NOC responds that the transmitte
is either actively performing the pointing test or is queued to perform the test 
when test resources become available in the NOC. This is a normal condition fo
initial installation. The transmitter may also periodically go into this condition fo
short periods of time (less than 5 seconds) to perform periodic transmit pointin
tests. These periodic tests are performed to ensure that the antenna is pointed
accurately.

The transmitter is queued for a 
transmit pointing test

This condition can occur during installation when the Antenna Pointing softwar
on the installation computer requests a transmit pointing test and the NOC has
responded that the transmitter is queued for the next available test time. It may
also occur when the transmitter is performing periodic background transmit 
pointing tests at the same time that other users on the network have requested
tests. This is a normal state after initial installation.

The transmitter is performing a 
transmit pointing test

This condition occurs when one of the following tests are active:
• During installation, the Antenna Pointing software requests that the transmitte

perform a transmit pointing test. This condition will persist until the Antenna 
Pointing software exits from the transmit pointing test mode.

• The DW4020 performs a periodic background transmit pointing test to make
sure that the antenna is still pointed correctly. This periodic test takes less tha
5 seconds.

If the problem persists, try power-cycling the DW4020 by unplugging the wall 
outlet and plugging it back in.

Table 6: Transmit status (TxCode) messages and corrective actions
Chapter 3 • The User Interface
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The transmitter is disabled 
because a transmit pointing 
test failed

This condition occurs when the transmitter fails a transmit pointing test. This 
indicates that the transmitter did not meet the minimum specifications required
This is likely due to an antenna installation problem. The antenna installer need
to fine-point the antenna. The transmitter will not transmit until the transmit 
pointing test passes.

The transmitter is disabled 
pending a transmit pointing 
test

This condition occurs when the transmitter is required to perform a periodic 
background transmit pointing test, but has not been able to perform the test 
within the time window required. The transmitter is expected to be in this 
condition for no more than two minutes at random periodic intervals. This 
condition can also occur after the transmitter is first powered on after it has bee
powered off for more than a day. If the unit remains in this condition for more 
than two minutes, then the automated transmit pointing components in the NO
are likely experiencing problems. This condition should clear in a few minutes.

The transmitter is disabled 
because a transmit pointing 
test cannot be performed

This condition occurs when the transmitter cannot perform the transmit pointin
test when initially installed or when the transmitter is required to range. The 
condition indicates that the NOC components needed to perform the transmit 
pointing test are not operational.

Figure 36: DW4020 connections

Table 6: Transmit status (TxCode) messages and corrective actions
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CAUTION

Never unplug the power cord from the DW4020 while it is powered 
on. Always disconnect the power cord from the power supply, wall 
outlet, or surge protector.
Receive Status messages T
Chapter 3 • The User Interface
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Download from 
he following messages may appear in the Receive Status field. 
The Comments section gives more information about each code, 
and describes any possible corrective measures. See Figure 36 on 
page 41 for corrective measure involving cables or the power 
supply. Power cycling means to unplug the power cord from the 
wall outlet or surge protector, wait 10 seconds, and plug it back 
in.

If corrective measures do not solve a problem, contact technical 
support.

RxCode 5 means the receive modem is working properly. It is the 
code you will see most of the time.

Note: Remember that IRU refers to the receive modem, and that 
ITU refers to the transmit modem.
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Table 7: Receive code (RxCode) messages and corrective actions

meric 
Code

Message Displayed Comments

The receiver is not connected Please make sure that the Indoor Receive Unit is connected to th
Gateway via the USB cable. If the cable is connected and you st
see this message, use the following steps for troubleshooting:
• Make sure the power supply is correct. The power supply shou

be Part # 1031105-0001.
• Try power-cycling the DW4020 by unplugging the power cord 

from the wall outlet and then plugging it back in.
• Try using a different USB cable.
• If none of the above resolve the issue, you may need to replac

the Indoor Receive Unit.

The receiver is in pointing mode This condition indicates that the installer is performing antenna 
pointing. In this mode, the transmitter is disabled for safety 
reasons since the installer is working near the dish. If this occurs
during normal operation, try power-cycling the DW4020 by 
unplugging the power cord from the wall outlet and then pluggin
it back in.

The receiver is in factory or NOC mode This status is for DW4020 testing purposes only. You should neve
see it. If this occurs during normal operation, try power-cycling th
DW4020 by unplugging the power cord from the wall outlet and 
then plugging it back in.
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The receiver is not locked to a signal If the DW4020 had been operating previously, this status is 
probably due to inclement weather conditions and will be 
corrected when the weather improves. This condition can also 
indicate that the IRU is unable to receive the signal from the NOC
This is also associated with a signal level less than 30. This 
occurs if there is a weather outage at the user location, a NOC 
outage due to inclement weather or other reasons, a misaligned o
faulty antenna, or faulty cabling. If this keeps happening under 
normal weather conditions, make sure the power supply is correc
The power supply should be Part # 1031105-0001. If the power 
supply is correct, try power-cycling the DW4020 by unplugging th
power cord from the wall outlet and then plugging it back in.

The receiver is locked to the wrong network This condition should only be seen during installation and occur
when the receiver is locked to a signal, but the signal ID does no
match the ID that was assigned to the user during commissionin
or the ID that was entered by the installer during manual pointing
If this occurs during normal operation, it may be due to the user 
changing acquisition parameters, including frequency and/or 
location of satellite, or the antenna becoming misaligned.

The receiver is operational This is the normal operating state where the receiver is receiving
data from the NOC. Only when the receiver is in this state will th
transmitter operate correctly.

The receiver is not detecting a signal This condition occurs when the IRU is not detecting any type of 
radio signal from the antenna. This could indicate that the cablin
between the receiver and the antenna is faulty or that the receive
itself is faulty. Check that the cables are firmly connected on the
DW4020. Also, make sure that the power supply is correct. The 
power supply should be Part # 1031105-0001. Try power-cycling
the DW4020 by unplugging the power cord from the wall outlet 
and then plugging it back in.

The receiver is locked to an unknown 
network

This condition should only be seen during installation and occur
when the receiver is locked to a signal but there is no DIRECWA
Network ID on that signal. If this occurs during pointing or 
commissioning, the antenna has not been pointed correctly. If it 
occurs during normal operation, it may be due to the user 
changing acquisition parameters, including frequency and/or 
location of satellite, or the antenna becoming misaligned. The 
former condition can be corrected by re-commissioning the site.
The latter requires an antenna repointing.

Table 7: Receive code (RxCode) messages and corrective actions
Receive Statistics T
t

Download from 
he Receive Statistics screen contains information about how 
he receive modem is processing frames. It contains the following 

fields. See Figure 37.

• Receive Status - displays receive modem status messages. 
Click on Receive Status to view a list of receive status 
messages. Click on a receive status message to learn more 
about it.
Chapter 3 • The User Interface
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• Frames Received - displays the number of frames the receive 
modem has received.

• Frames with Errors- displays the percentage of bad frames 
received.

• Bad Key Frames - packets received over satellite that could 
not be decrypted successfully. A non-zero value indicates 
commissioning problems. (Clicking on the field will display 
this definition in the Web interface.)
Figure 37: Receive Statistics screen
Transmit Statistics T
t

he Transmit Statistics screen contains information about how 
he transmit modem is processing transmissions. It contains the 

following fields. See Figure 38.

• Transmit Status - displays receive modem status messages. 
Click on Transmit Status to view a list of transmit status 
messages. Click on a transmit status message to learn more 
about it.

• Number of Successful Transmissions- displays the number of 
successful transmissions.
Www.Somanuals.com. All Manuals Search And Download.
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• Number of Failed Transmissions- number of times the ITU 
failed to transmit data.

• Number of Packets Submitted for Transmission- number of 
packets submitted to the transmit modem.
Figure 38: Transmit Statistics screen
System Information T
W

he System Information screen displays a number of fields. 
hile all the information may be useful at some time, the most 

important is discussed below. 

Note: Print the System Information screen and give it to the 
customer. It will be helpful should they need to call Customer 
Care and not be able to access the User Interface.

• Gateway section
– Commissioned - displays whether the DW4020 is 

commissioned.
– IP Address - use this as the default Gateway on the 

computers connected to the DW4020.
– Subnet Mask - use this as the default Gateway on the 

computers connected to the DW4020.

• Indoor Receive Unit (Receive Modem) section
– Serial number - needed to identify customer’s receive 

modem when troubleshooting.

• Satellite Transponder section
Chapter 3 • The User Interface
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– Longitude - displays the satellite’s longitude.
– Receive Polarization - polarization orientation.

• Software Configuration section- WEB Acceleration, NAT, 
and DHCP are enabled or disabled as per a customer’s 
service offering and cannot be changed by the customer.

– Web Acceleration - Allows fast access to Internet 
Web sites and high-speed data download from the Internet. 

– Network Address Translation (NAT) - typically 
used to allow multiple computers to share a single address 
on the Internet. It also allows preconfigured remote 
networks to be integrated easily with the DIRECWAY 
network.

– Dynamic Host Configuration Protocol (DHCP) 
if enabled, this simplifies the network configuration of the 
computers. The computers just need to be set up to “Obtain 
IP address automatically.”

– Firewall - can be enabled by the user and configured to 
help deflect unwanted Internet traffic.
Figure 39: System Information; print and save this screen
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ou may lose connectivity to a particular server due to the 
nternet and/or the satellite network being heavily loaded or due 
o the server being down. If possible, check connectivity to some 

other server on the Internet to ensure it is not a server specific 
problem. Follow the procedure below for troubleshooting:
Network Operations Center
(NOC) Connectivity

U
c

se the Connectivity Test from the left pane to check 
onnectivity to the DIRECWAY NOC.

Note: You may want to open a second browser window to be able 
to access this help page while conducting the Connectivity Test.

1. Click on Connectivity Test on the left hand side of the User 
Interface. The screen in Figure 40 appears.

2. Run the test. A message will appear, informing you if the test 
was successful.
If the connectivity test succeeds, try pinging the NOC Router 
Address from the computer. This address can be obtained 
from the System Information page. See System Information 
on page 45.
If this succeeds, skip to the Internet Connectivity test below.
If this fails, the default gateway is probably not set correctly 
on the computer’s network settings. The default Gateway 
should be the Gateway IP address. Fix this in the computer's 
network settings and repeat the connectivity test.
If the test still fails, power-cycle the DW4020 by unplugging 
the power cord from the wall outlet and plugging it back in. If 
this doesn't fix the problem, call Customer Care.
If the connectivity test fails, check the DW4020 configuration 
via the System Information page.
Chapter 3 • The User Interface
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Figure 40: Connectivity Test
Internet Connectivity T
(

ry pinging the DIRECWAY Internet server 
www.direcway.com).

Note: If you are an enterprise customer and your enterprise has a 
backbone connection to the Network Operations Center, the 
DIRECWAY Internet server may not be accessible. In such a case, 
you should try to ping your enterprise's Internet server.
If pinging succeeds, the problem is probably in the particular 
server that you were trying to access or there may be a temporary 
Internet or your enterprise's backbone connection outage. Please 
try repeating the test after sometime.

If pinging fails, check your DNS Server settings in System 
Information. If you are using the DIRECWAY DNS Server, make 
sure the DNS Settings include the "198.77.116.8" address. If you 
are a business customer contact your System Administrator.

If this problem persists, please contact Customer Care for further 
assistance.
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he User Interface enables customers to enable a firewall and 
onfigure its rules. If they use the firewall, they must configure it 

properly for maximum protection. They should be aware that 
even an optimally configured firewall cannot be guaranteed to 
keep out all potentially harmful traffic.

A discussion of the principles applied when setting up a firewall 
is in the DW4020 User Guide (HNS 1032564-0001). There is 
also a great deal of information in the FAQ section of the Web 
interface Help menu.
Note: It is important to remember that the firewall checks 
inbound packets only. If you want to check outbound packets, 
you must obtain another firewall and install it on the network or on 
selected hosts on the network.
The Settings Menu T
p

he firewall allows configuration of up to 10 rules for blocking 
ackets received over the satellite link. Five port numbers or 5 

protocol types in each rule. Which Source IP Addresses are 
examined for each rule can also be specified. The table below lists 
some common port numbers and protocols.

1. Open the User Interface and go to Home→Firewall→Settings. 
The screen in Figure 41 appears.

2. Select the Enable Firewall checkbox to enable the firewall.
3. Determine which rule number you want to create or modify.
4. Select a rule type.
5. Select a port or protocol number. 
6. Type the source IP address that you want the firewall to check 

for.
7. You can leave the subnet mask set at 255.255.255.255. Set 

the Subnet Mask to 0.0.0.0 if you would like to block access 
from everywhere in a particular rule.

8. Click on the Save Configurations button to save the firewall 
settings.
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Figure 41: Firewall Settings
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Table 8: Port numbers and protocols

Port Number Internet Application or Protocol

7 Echo

21 FTP control port

23 Telnet

25 Simple Mail Transfer Protocol (SMTP)

53 Domain Name Server (DNS)

70 Gopher

79 Finger

80 Hyper Text Transfer Protocol (HTTP)

107 Remote Telnet Service (RTELNET)

110 Post Office Protocol - Version 3 (POP3)

119 Network News Transfer Protocol (NNTP)

6667 Internet Relay Chat (IRC)
The Help Menu T
he Help Menu contains information about receive and transmit 
modem status messages, the firewall, installation, 
troubleshooting, and other topics. Review it to become familiar 
with the User Interface and with the DW4020. Access it by 
clicking on Help.

Note: Print the answer to the entry in the User Interface 
Troubleshooting page, “I am unable to access the DW4020 Web 
interface. Ping doesn’t work also.” The information on this page 
will help you if you cannot access the User Interface.
Figure 42: Help Menu
Chapter 3 • The User Interface
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myDIRECWAY C
Chapter 3 • The User Interface
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ustomers can click on myDIRECWAY to go to 
myDIRECWAY.com. Members get access to a variety of 
interactive tools and can check usage online, test satellite speed, 
manage passwords, and more.

myDirecway.com is not an installer resource.
Software updates and 
the User Interface

T
a
u

he DW4020 software will be updated periodically to provide 
ccess to new features and for performance enhancements. Any 
pdates that are not discussed in the User Guide can be found on 

the What's New page in the DW4020 User Interface. The link to 
this page will be available from the User Interface Home page 
and also from the FAQ page.
Www.Somanuals.com. All Manuals Search And Download.
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Chapter 4
DW4020 LEDs and troubleshooting

The DW4020 LEDs can provide information for troubleshooting 
units that aren’t functioning at all, or don’t seem to be functioning 
as well as they might. The LEDs can show modem or Gateway 
operational status--whether they are connected, powered up, or 
working at al. The LEDs can also blink in patterns that 
correspond to the TxCode and RxCode discussed in The System 
Status indicator on page 36. Finally, the Gateway Ethernet ports 
have LEDs that indicate their status.
The DW4020 LEDs T
m

he receive modem has a RX and a READY LED. The transmit 
odem has a TX and a READY LED. The Gateway has a 

STATUS and READY LED.

Note: Whenever the LEDs do not function properly as described 
below, check to be sure you have the correct power supply, PN 
1031105-0001.
Chapter 4 • DW4020 LEDs and troubleshooting
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DW4020 LEDs status T
D
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his section describes the LEDs’ appearance during typical 
W4020 operation. It also describes their appearance when some 

basic problem is occurring.
Normal operation, no
transmit or receive

W
t
R

hen the DW4020 is powered on but not receiving or 
ransmitting data, it appears as shown in Figure 43. The modems’ 
EADY LEDs are continuously lit. Both the Gateway LEDs are 

continuously lit.
Figure 43: DW4020 normal operation, no data received or transmitted

Modems’ READY 
LEDs continuously lit

Both Gateway LEDs 
continuously lit
bleshooting
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Normal operation, data
being sent and received
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Download from 
uring normal DW4020 operation, the modems’ READY LEDs 
re continuously lit, the RX and TX LEDs blink as they pass data, 
nd both the Gateway LEDs are continuously lit, as shown in 

Figure 44.
Figure 44: Normal operation, data being sent and received

RX LED blinks as 
modem passes 
data; READY 
LED on 
continuously

TX LED blinks as 
modem passes 
data; READY 
LED on 
continuously

Gateway STATUS 
and READY LEDs 
continuously lit
Problem: receive modem
READY LED not on

I
m
f

f the DW4020 is not operating normally and the receive 
odem’s READY LED is not lit, as shown in Figure 45, take the 

ollowing steps:

• Check to make sure the power cord is securely attached to the 
receive modem and plugged into the wall outlet or surge 
protector. See Figure 46. If the power cord was loose, the 
receive modem READY led will come on when power is 
restored.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Receive modem READY LED still does not come on, 
power cycle the DW4020 by unplugging the power cord from 
the wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Note: Often, if the receive modem READY LED is not lit, the 
other modem LEDs will not be lit either.
Chapter 4 • DW4020 LEDs and troubleshooting
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Figure 45: Receive modem READY LED not lit

Figure 46: DW4020 power and cable connections

Receive modem READY LED 
not lit. Note that in many 
cases other modem LEDs 
will not be lit either.
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Transmit modem READY
LED not lit
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f the transmit modem is not operating normally and its READY 
ED is not lit, as shown in Figure 47, take the following steps.

• Check that the receive modem READY LED is continuously 
lit. If not, try the sequence in Problem: receive modem 
READY LED not on on page 55.

• Check that the 25-pin connector is attached securely. See 
Figure 46.

• Check to make sure the power cord is securely attached to the 
receive modem and plugged into the wall outlet or surge 
protector. See Figure 46. If the power cord was loose, the 
transmit modem READY led may come on.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the transmit modem READY LED still does not come on, 
power cycle the DW4020 by unplugging the power cord from 
the wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Figure 47: Transmit modem READY LED not lit

Receive modem READY LED 
continuously lit, showing that it is 
functioning

Transmit modem READY LED 
not lit
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Gateway LEDs not lit I
n
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f the Gateway does not seem to be functioning and its LEDs are 
ot lit, and the receive modem READY LED blinks as shown in 

Figure 48, take the following steps.

• Check to make sure the power cord is securely attached to the 
Gateway and receive modem and plugged into the wall outlet 
or surge protector. See Figure 46. If the power cord was 
loose, the Gateway and receive modem READY LEDs will 
come on when power is restored.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Gateway READY LED still does not come on, power 
cycle the DW4020 by unplugging the power cord from the 
wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Figure 48: Gateway LEDs not lit

Receive modem READY 
LED blinks

Gateway LEDS are 
not lit
bleshooting
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Gateway LEDs flash, receive
modem READY LED off or

flashing

I
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f the Gateway does not seem to be functioning and its STATUS 
ED flashes amber, and the receive modem READY LED blinks 
r is not lit, as shown in Figure 48, take the following steps.

• Check to make sure the USB cable is securely attached to the 
Gateway and receive modem. See Figure 46. If the cable was 
loose, the Gateway and receive modem READY LEDs will 
come on when it is reattached.

• If securing the USB cable does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Gateway STATUS LED still does not come on 
continuously, power cycle the DW4020 by unplugging the 
power cord from the wall outlet or surge protector, waiting 
ten seconds, and plugging it back in.

• If the problem persists, contact technical support.
Figure 49: Gateway STATUS LED blinks amber

Receive modem READY 
LED blinks or is not lit

Gateway STATIS LED 
blinks amber
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LED blinking indicating
status codes

T
p
T
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he DW4020 modems’ READY LEDs can blink in various 
atterns. These patterns correlate to the status codes discussed in 
ransmit Status messages on page 37 and Receive Status 

messages on page 42. If you can see the patterns, you also have 
access to the User Interface. It will be easier to find out what the 
status of the DW4020 is via the interface than the LED status 
blinking. The blink patterns are described below for your 
information.
he 
Transmit 
READY LED 

Pattern

Corresponding transmit status messages

Off 4 (or powered off)

On 8

2 Long,
1 Short

1

2 Long,
2 Short

2

2 Long,
3 Short

11

1 Long,
1 Short

3

1 Short 5

2 Short 10, 13, 14, 15,16, 21, 22, 23

3 Short 6, 7

4 Short 12, 17

Slow
Alternating

9,18,19,20

Fast
Alternating

The ITU interface testing – This is a continuous fast blinking pattern, with the Transmit LED being t
inverse of the Ready LED. No corresponding message.
bleshooting
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2 S
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1 L
1 S
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Receive 
EADY LED 
Pattern

Corresponding receive status message

st
ternating

Prior to downloading software– This is a continuous fast-blinking pattern, with the RX LED being the invers
of the Ready LED. No corresponding message.

ow
ternating

 1

5

ong,
hort

3,6

ong,
hort

4,7

hort 0

ong,
hort,
ong

2

Table 9: Receive modem READY LED blink patterns
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Ethernet port LEDs E
a
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ach of the four Ethernet ports on the DW4020 has two LEDs 
ssociated with it. One LED is green and one is yellow. See 

Figure 50).

The green LED will be on if power is applied to the DW4020 and 
a 100baseT Ethernet device is connected to the corresponding 
Ethernet port. Otherwise, the green LED will be off.

If the power is on and the light is off while a network device is 
connected, then the device is a 10baseT device and the port is 
autosensing.

The yellow LED will also be on when power is applied to the 
DW4020. It will flash momentarily when there is LAN activity 
on the corresponding Ethernet port.
Figure 50: Ethernet port LEDs

Green LED Yellow LED
bleshooting
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G

Dotted decimal notation - An IP address 
consists of 32 bits. Rather than working with 32 
bits at a time, it is a common practice to segment 
the 32 bits of an IP address into four 8-bit fields 
called octets. Each octet is converted to a 
decimal number (the Base 10 numbering 
system) in the range 0-255 and separated by a 
period (a dot). 

Dynamic Host Configuration Protocol (DHCP) - 
a communications protocol that lets network 
administrators manage centrally and automate 
the assignment of Internet Protocol (IP) 
addresses in an organization's network.

. 

Enterprise - an entity autonomously operating a 
network using TCP/IP and in particular 
determining the addressing plan and address 
assignments within that network. 

Gateway - the receive modem, the transmit 
modem, and the Gateway host when cabled 
together form the Gateway. Also called the 
DW4020.

Gateway host - downloads code to the IRU, 
performs PEP and decompression functions, and 
monitors and controls the operation of the 
IRU/ITU. In addition, the Gateway host 
supports configuration, status monitoring, and 
commissioning using a "dumb terminal" 
connected to an asynchronous serial port.
Download from Www.Somanuals.co
H
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Host - In packet- and message-switching 
communications networks, the collection of 
hardware and software that makes use of packet 
or message switching to support user-to-user, 
i.e., end-to-end, communications, interprocess 
communications, and distributed data 
processing. More simply, any computer that has 
full two-way access to other computers on the 
Internet.

Internet Assigned Numbers Authority (IANA) - 
the organization that has overseen the allocation 
of Internet Protocol addresses to Internet service 
providers (ISPs).

Internet protocol (IP) - The method or protocol 
by which data is sent from one computer to 
another on the Internet. Each computer (known 
as a host) on the Internet has at least one IP 
address that uniquely identifies it from all other 
computers on the Internet. The protocol within 
TCP/IP that governs the breakup of data 
messages into packets, routing the packets from 
sender to destination network and station, and 
reassembling the packets into the original data 
messages at the destination.

Internet service provider (ISP) - A business that 
supplies Internet connectivity services to 
individuals, businesses, and organizations. 
Some ISPs are large national or multinational 
corporations that offer access in many locations, 
while others are limited to a single city or 
region.
 • Glossary
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IP address - a 32-bit number that identifies each 
sender or receiver of information that is sent in 
packets across the Internet. An IP address has two 
parts: the identifier of a particular network on the 
Internet and an identifier of the particular device 
(which can be a server or a workstation) within 
that network. On the Internet itself - that is, 
between the router that move packets from one 
point to another along the route - only the network 
part of the address is looked at.

L

N

P

Local area network (LAN) - a group of 
computers and associated devices that share a 
common communications line and typically 
share the resources of a single processor or 
server.

National Operations Center - A place from 
which a network is supervised, monitored, and 
maintained.

Network Address Translation - a method of 
connecting multiple computers to the Internet 
(or any other IP network) using one IP address.

Performance enhancing proxy (PEP) - modules 
that provide TCP acceleration. PEP is used to 
improve the performance of the Internet 
protocols on network paths where native 
performance suffers due to characteristics of a 
link or subnetwork on the path.

Private IP addressing - A computer on the 
Internet is identified by its IP address. In order 
to avoid address conflicts, IP addresses are 
publicly registered with the Network 
Information Centre (NIC). Computers on private 
TCP/IP LANs however do not need public 
addresses, since they do not need to be accessed 
by the public. For this reason, the NIC has 
reserved certain addresses that will never be 
registered publicly. These are known as private 
IP addresses.
 • Glossary
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Receive modem - downloads data from the 
satellite. Also known as indoor receive unit 
(IRU).

Router - a device or, in some cases, software in a 
computer, that determines the next network 
point to which a packet should be forwarded 
toward its destination.

Signal quality factor (SQF) - an integer value 
from 0-99 that indicates the strength of the 
received satellite signal relative to noise.

Subnet mask - a 32-bit value that is used to 
distinguish the network ID from the host ID in 
an arbitrary IP address. Each host on a network 
requires a subnet mask.

TCP/IP internet protocol suite - the basic 
communication language or protocol of the 
Internet.

TCP spoofing - technique of using local devices 
to answer TCP overhead messages. Also known 
as Turbo Internet.

Transmission control protocol (TCP) - a set of 
rules (protocol) used along with the Internet 
Protocol (IP) to send data in the form of 
message units between computers over the 
Internet. While IP takes care of handling the 
actual delivery of the data, TCP takes care of 
keeping track of the individual units of data 
(called packets) that a message is divided into 
for efficient routing through the Internet.

Transmit modem - sends (uploads) data to the 
satellite. Also known as indoor transmit unit 
(ITU).
All Manuals Search And Download.



Turbo Internet - A high-speed satellite link from 
the Internet, allowing users to download 
information at a very high rate. Turbo Internet 
services provide asymmetric connections 
between a customer PC and the Internet. This 
enables users to download very large files at a 
very high rate of speed.
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 • Glossary
1031484-0001 Revision 2 65

m. All Manuals Search And Download.



 • Glossary
66 1031484-0001 Revision 2

Download from Www.Somanuals.com. 
All Manuals Search And Download.



Abbreviations and Acronyms
Download from 
Abbreviation 
or Acronym

Term

DHCP dynamic host configuration protocol

GWH Gateway host

IANA Internet Assigned Numbers Authority

IP Internet protocol

IRU indoor receive unit

ISP Internet service provider

ITU indoor transmit unit

LAN local area network

NAT network address translation

NMC network management center

NOC network operations center

OPI outdoor pointing interface

PEP performance enhancing proxy

RX receive

SDL software download

TCP transmission control protocol

TCP/IP transmission control protocol/Internet protocol

TX transmit
 • Abbreviations and Acronyms
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Appendix A
Lat/Long Decimals to Minutes Table

Use the following procedure to determine your latitude and 
longitude decimal to minutes conversion.

1.  Enter the whole number part of the site's longitude into the 
VSAT Longitude in degrees field in the Configure Boot 
Parameters screen.

2. Take the two digits immediately to the right of the longitude 
decimal point (without doing any rounding) and use the chart 
below to translate these two digits into the number of 
minutes.

3. Enter the minutes number into the VSAT Longitude in minutes 
field in the Configure Boot Parameters screen.

4. Repeat steps 1, 2, and 3 for the VSAT Latitude in degrees and 
VSAT Latitude in minutes fields.

For example, if the site's coordinates are:

Longitude:  77.2395 deg. West
Latitude:   38.8351 deg. North

You should enter:

VSAT Longitude in degrees: 77
VSAT Longitude in minutes: 14
VSAT Longitude Hemisphere (0 = East, 1 = West) <1>: 1
VSAT Latitude in degrees: 38
VSAT Latitude in minutes: 50
VSAT Latitude Hemisphere (2 = North, 3 = South) <2>: 2
Appendix A • Lat/Long Decimals to Minutes Table
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Right of 
Decimal

Minutes
Right of 
Decimal

Minutes
Right of 
Decimal

Minutes

.01 1 .36 22 .71 43

.02 1 .37 22 .72 43

.03 2 .38 23 .73 44

.04 2 .39 23 .74 44

.05 3 .40 24 .75 45

.06 4 .41 25 .76 46

.07 4 .42 25 .77 46

.08 5 .43 26 .78 47

.09 5 .44 26 .79 47

.10 6 .45 27 .80 48

.11 7 .46 28 .81 49

.12 7 .47 28 .82 49

.13 8 .48 29 .83 50

.14 8 .49 29 .84 50

.15 9 .50 30 .85 51

.16 10 .51 31 .86 52

.17 10 .52 31 .87 52

.18 11 .53 32 .88 53

.19 11 .54 32 .89 53

.20 12 .55 33 .90 54

.21 13 .56 34 .91 55

.22 13 .57 34 .92 55

.23 14 .58 35 .93 56

.24 14 .59 35 .94 56

.25 15 .60 36 .95 57

.26 16 .61 37 .96 58

.27 16 .62 37 .97 58

.28 17 .63 38 .98 59

.29 17 .64 38 .99 59

.30 18 .65 39

.31 19 .66 40

.32 19 .67 40

.33 20 .68 41

.34 20 .69 41

.35 21 .70 42
 Minutes Table
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Appendix B
The Internet and the DW4020
Internet protocol (IP) 
and transmission 
control protocol (TCP)

T
d
d
d

he Internet Protocol (IP) provides a format for moving packet 
ata from node to node. The IP enables data to move from 
epartment to organization, to a region, across regions, to 
estination organizations, and to departments. The IP layer serves 

as the basis for other protocol layers, as shown in Table 10.

The transmission control protocol (TCP) verifies correct delivery 
of data. TCP detects errors or lost data. TCP initiates 
retransmission so that the data is eventually correctly received.

The use of these two protocols, together along with a suite of 
other protocols, has been given the official name TCP/IP internet 
protocol suite, or, more commonly TCP/IP.
Table 10: The Internet Protocol (IP) is the basis for other protocol layers

FTP – File Transfer Protocol IP – multicast

• Reliable method for delivering files from a host 
machine to remote personal computers

• Universal way to broadcast digital content to 
multiple locations

• Takes maximum advantage of DIRECWAY 
satellite star network topology

TCP – Transmission Control Protocol UDP – User Datagram Protocol

• Session oriented protocol
verifies correct data delivery

• For delivering web pages and mission critical data

• Datagram oriented protocol
method for delivering short messages between 
two points

• Basis of IP-multicast

IP – Internet Protocol

• Format for moving data from node to node
• Basis for all of the above protocols
• Becoming de facto standard for digital transmission – data, video and audio
• Widespread acceptance in the corporate world
Turbo Intranet™ T
t

urbo Intranet is an HNS technique that increases the TCP 
hroughput across the satellite link. Turbo Intranet involves using 

local devices to answer TCP overhead messages in the place of 
distant devices. These devices efficiently send outroute data over 
the spacelink and buffer the data for transfer to local hosts within 
Appendix B • The Internet and the DW4020
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their TCP limits, vastly increasing the overall throughput. This 
technique is also known as TCP spoofing.
IP addressing and the
DW4020

I
w
a

P provides a method of constructing a network of networks 
here computers and networks made by different manufacturers 

nd conforming to different standards can exchange information. 
The IP is layered on top of vendor-specific protocols. The data to 
be sent is divided into packets. IP directs each packet based on a 
four-byte destination address, the IP address, in the IP packet 
header. 

The Internet Assigned Numbers Authority (IANA) assigns ranges 
of IP addresses to Internet Service Providers (ISPs), who assign 
ranges to organizations, who are their customers. The 
organizations, in turn, assign individual numbers within that 
range to each of their networked computers.

In this way, every computer on a network, (each computer on a 
network may also be referred to as a "host") is assigned a unique 
number that identifies it and its network. Actually, the IP address 
is assigned to the connection rather than to the computer itself. 
However, it is assumed that the computers are not moved from 
their respective connections. By convention, these IP addresses 
are written by converting each byte (8 bits) into a decimal number 
(0 to 255) and separating each byte by a period as in 192.77.43.4. 
This format, called dotted decimal notation, is used to enter IP 
addresses.

It is important to note that IANA defines an "enterprise" as an 
entity autonomously operating a network using TCP/IP and in 
particular determining the addressing plan and address 
assignments within that network. Thus, in the context of TCP/IP, 
installing networks or DW4020s, or assigning IP addresses, the 
term enterprise refers to an organization defined in this way.

As an example of Internet address assignment, a small business 
owner with four networked computers might apply to IANA or its 
ISP for a “class C” network. In the IP address for a class C 
network the first three bytes identify the network and the last byte 
identifies the individual computer. The business owner is 
assigned the numbers 192.77.43.*, where * represents a “wild 
W4020
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card.” The business owner can then assign his individual 
computer connections the numbers as shown in Figure 51.
Figure 51: IP addresses assigned to individual computer connections

Internet
address 192.77.43.2 192.77.43.3 192.77.43.4 192.77.43.5
A large organization like a university might apply for a class B 
network, in which the first two bytes are assigned and the last two 
bytes are available to the university to assign up to 64 thousand 
computers in sub-network LANs. For example, the university 
might be assigned a number like 170.15.*.*. The university, in 
turn, could make assignments such as: 170.15.100.* = Physics 
department LAN sub-network, 170.15.101.* = central library 
LAN1 sub-network, and so on. It is a common practice to assign 
the third byte to individual department LANs and the fourth byte 
to individual computers within each department.

A very large entity might require a class A network that would 
allow over 16 million individual IP address assignments. Table 11 
gives the ranges of IP addresses IANA reserves for specific 
purposes. 

HNS customers have already acquired IP address ranges and 
supply these as needed to HNS installers.

Note, however, that many organizations of various sizes now use 
private IP addressing (see Private IP addresses below). These 
organizations do not need to assign a unique public IP address to 
each computer (or "host") on their networks. 
Table 11: IP Address ranges

Category Lowest address Highest address Example or comment

Class A network 0.1.0.0 126.0.0.0 9.*.*.* for IBM Corp.

Class B network 128.0.0.0 191.255.0.0 170.15.*.* – a university

Class C network 192.0.1.0 223.255.0.0 192.77.43.* – small business

D – multicast 224.0.0.0 239.255.255.255
Ap
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s Internet use has increased, more and more IP addresses have 
een assigned. There is not an infinite number of IP addresses, 

and IANA is concerned that the supply of unique IP addresses 
could be exhausted. One way to conserve IP addresses is to assign 
them only to hosts that are designated as "public." Hosts that are 
designated as "private" do not need unique IP addresses.
Types of hosts I
ANA has created three categories of hosts:

Category 1: hosts that do not require access to hosts in other 
enterprises or the Internet at large; hosts within this category 
may use IP addresses that are unambiguous within an 
enterprise, but may be ambiguous between enterprises.
Category 2: hosts that need access to a limited set of outside 
services (e.g., E-mail, FTP, netnews, remote login) which can 
be handled by mediating gateways (e.g., application layer 
gateways). For many hosts in this category an unrestricted 
external access (provided via IP connectivity) may be 
unnecessary and even undesirable for privacy/security 
reasons. Just like hosts within the first category, such hosts 
may use IP addresses that are unambiguous within an 
enterprise, but may be ambiguous between enterprises.
Category 3: hosts that need network layer access outside the 
enterprise (provided via IP connectivity); hosts in the last 
category require IP addresses that are globally unambiguous.

Hosts in categories 1 and 2 are private hosts. Hosts in Category 3 
are public hosts. Hosts in categories 1 and 2 do not need to be 
directly accessible from other networks. These hosts might 
include airport arrival/departure displays, automatic teller 
machines, or equipment at clerical positions. Thus, these private 
hosts do not need unique IP address numbers. The IP addresses 
private hosts are assigned need only be unique within the 
network; they need not be directly accessible from other 
networks.

In addition, for security reasons, many enterprises use application 
layer gateways to connect their internal network to the Internet. 
The internal network usually does not have direct access to the 
Internet; thus, only one or more gateways are visible from the 
Internet. In this case, the internal network can use non-unique IP 
network numbers.

In short, there are many devices that can be connected on an 
internal Internet or intranet that need never be assigned unique IP 
addresses. In this way, IP addresses are conserved.
Private address space I
s

ANA has reserved the following three blocks of the IP address 
pace for private internets:
W4020
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10.0.0.0        -   10.255.255.255 (10/8 prefix)
172.16.0.0      -   172.31.255.255 (172.16/12 prefix)
192.168.0.0     -   192.168.255.255 (192.168/16 prefix)

The first block is the "24-bit block," the second is the "20-bit 
block," and to the third is "16-bit" block. Note that the first block 
is nothing but a single class A network number, while the second 
block is a set of 16 contiguous class B network numbers, and 
third block is a set of 256 contiguous class C network numbers.

An enterprise that decides to use IP addresses out of these address 
spaces can do so without any coordination with IANA or an 
Internet registry. The address space can thus be used by many 
enterprises. Addresses within this private address space will only 
be unique within the enterprise, or the set of enterprises which 
choose to cooperate over this space so they may communicate 
with each other in their own private internet. An enterprise that 
requests IP addresses for its external connectivity will never be 
assigned addresses from the blocks defined above.
Private IP addressing and
DW4020 customers

D
r
w

W4020 customers who use private addressing must install a 
outer or switch between the DW4020 and their network. They 
ill also need to provide the installer with the LAN Gateway 

address and, if applicable, the LAN subnet mask (see Configuring 
the Gateway host in Chapter 3).
Appendix B • The Internet and the DW4020
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he DW4020 provides connectivity from a satellite network to 
ultiple computers.

From the point of view of the individual computer user, the 
DW4020 provides the link to the outside world. DW4020s direct 
data traffic by inspecting the IP addresses. A DW4020 is assigned 
two IP addresses, one in each network that it links.

Figure 52 illustrates a typical connection scheme for the 
DW4020.
Figure 52: Typical DW4020 connection scheme

1++533+78-95
�()4/,5�-
+/.)4.+)

����&&���� 3/+83*83++8) 3/+83*83++84 3/+83*83++87��������������3/+83*83++8*

#�
�����&&����: 3/+83*83++83

#�


����&&����
3/+83*85583

�������

����&&����
3/+83*8"""8���

9
��
������������������
�����
�
�
�

9$0

��9

�1!

��!

!�2
)*����

���� ���

-��%�#�


��7+)+
 Subnet mask T
i

he subnet mask defines the part of the IP address used to 
dentify computers on the same LAN from computers in other 

departments or elsewhere in the world. Computers on the same 
LAN can send messages directly to each other. Messages for 
other LANs and the rest of the world need to be sent through a 
router. In a scheme where the first three bytes identify the LAN 
network, the subnet mask is 255.255.255.0. The decimal number 
255 corresponds to the binary number 11111111. In IP address 
notation, 0 is interpreted to mean “this.”
W4020
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Appendix C
Installing the DW4020 Manually

The installation specification may direct you to install the 
DW4020 using the serial port. You would connect the installer 
laptop to the Gateway via the serial ports with a 9-pin female to 
female (F/F) null modem serial cable. That cable is not included 
with any DW4020 equipment.
Items needed for 
installation

Y
t
p

ou need all the items shown in Figure 53. Some of them are in 
he modem installation kit or inside the antenna box. You must 
rovide a 9-pin female/female (F/F) null modem serial cable. The 

serial cable is used to configure the DW4020 via the serial port. 
You will also need the installation specification or work order. 
This is provided to you by HNS. 
Figure 53: Items required for installation
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W4020 users must use a power supply with the part number 
/N: 1031105-0001. The part number is on a sticker on the power 

supply. Verify that you are using the correct power supply. Do not 
use anything but the power supply supplied with the DW4020 
system (1031105-0001). 

Be sure the power supply is labeled ADP 64AB B in the upper 
right hand corner of the label, above the bar codes. See Figure 54.

 

CAUTION
• This unit’s performance may suffer if the wrong power 

supply is used.
• This unit must be used with the power supply PN 

1031105-0001.
• When power needs to be removed from the receive 

modem, ALWAYS unplug the AC power cord from either 
the wall outlet, surge protector, or power strip.

• NEVER pull the power cord from the back of the receive 
modem. Doing so could damage the pins and also 
cause a short in the system.

• Power supply with the part number 1031105-0001 is to 
be used only in the United States and Canada.

• This unit must be used with 110-volt AC input.
• Other countries may have different standards and 

requirements.
Figure 54: PN: 1031105-0001 and ADP-64AB B above bar code

ADP-64AB BPN: 1031105-0001
 Manually
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ollow the steps below and refer to the illustrations on page 80 
hrough page 83 to assemble the DW4020 components. After you 
ssemble the components, you can plug in the power supply and 

observe the LED display cycling, as explained in The DW4020 
LEDs on page 86.
CAUTION
• The components must be stacked in this order: Gateway 

on bottom; transmit modem on top of Gateway; receive 
modem on top of transmit modem. See Figure 57.

• If the components are not stacked in the proper order, the 
receive modem may overheat and malfunction.

• Do not block any ventilation openings. Do not install near 
any heat sources such as radiators, heat registers, 
ovens, stoves, or other apparatus (including amplifiers) 
that produce heat.

• Recommended ventilation space around the top and 
sides of the DW4020 assembly should be approximately 6 
inches. Ventilation is necessary to avoid overheating.
1. Write down the receive modem serial number. It is located 
below the barcode on the back of the modem and is the 
second portion of the line. (For example, R1CF4B21E - 
00827500 would be Serial Number 827500.)

2. Be sure the power supply is not plugged into a wall outlet, 
surge protector, or power strip.

3. Lay two of the four clips on a table and mount the 
components as shown in Figure 55. Mount the Gateway first, 
then the transmit modem, then the receive modem.

4. Turn the component stack right side up and install the other 
two clips as shown in Figure 56.
Note: The Gateway and the transmit modem have a hole at 
the center of each of its four feet. There is a tab on the bottom 
of each mounting clip, which snaps into place on the Gateway 
when properly aligned over the hole.There is also a tab in the 
middle of each mounting clip, which snaps into place on the 
transmit modem when properly aligned over the hole.
Note:
5. Double-check that the components are installed in this order 
from top to bottom: receive modem, transmit modem, 
Gateway (see Figure 57).
Appendix C • Installing the DW4020 Manually
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Figure 55: Mount the components on two clips

Figure 56: Attach the other clips
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Figure 57: Component stack

Receive modem

Transmit modem

Gateway
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6. Connect the component interconnection cables. A short USB 
cable connects the receive modem and the Gateway. A 25-pin 
connector cable connects the transmit and receive modems. A 
power supply adapter cable provides power to the Gateway 
and receive modem (see Figure 58).

7. Connect the receive coaxial cable to the receive modem and 
the transmit coaxial cable to the transmit modem (see 
Figure 59). 

Figure 58: Attach interconnection cables

Figure 59: Attach coaxial cables

1����%��
%�&�%

�
	�

�

��

	��




�

�� ��'�
%�&�%

�������

!�2� �0��

�������$����
�&�����

)*(���� ���� ���
 �0��

1����%��
%�&�%

�� ��'�
%�&�%

�������

1����%��� �0��

�� ��'�
 �0��
 Manually

Www.Somanuals.com. All Manuals Search And Download.



Download from 
8. Connect up to four Ethernet cables to the network ports on 
the Gateway (see Figure 60). Either a straight-through or a 
cross-over Ethernet cable can be used. The four ports labeled 
1 through 4 are Ethernet 10 Base - T/100 network ports. They 
enable you to connect to other computers via an Ethernet 
connection. (Reference UL 60950, Annex NAA, Subclause 
reference 6, page 322.)

9. Attach the power supply cords to the power supply and to the 
power supply adapter. Ensure that the power cord is tightly 
connected to the power supply, modem, and Gateway (see 
Figure 61). The final assembly is shown in Figure 62.

Figure 60: Attach network cables
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Figure 61: Connect power cord

Figure 62: Final assembly
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fter you have assembled the DW4020, plug it into a 110 V wall 
utlet, power strip, or surge protector. The Gateway LED display 
ill cycle as shown in Table 12. The cycling completes in less 

than a minute.
Note: In countries outside North America, the DW4020 may be 
plugged, with a physical adapter, directly into a 220 V outlet. 
Different countries may have different standards and requirements. 
The transmit and receive modems have their own LEDs, which 
show their status. These are described in The DW4020 LEDs on 
page 86.

Note that normal Gateway operation alone doesn't imply normal 
DW4020 operation. The installation and commissioning process 
may not have been completed or software download (DLL) from 
the Network Operations Center (NOC) may not have been 
completed. Additional status information is available via the User 
Interface. See Chapter 3 – The User Interface, on page 33) and 
the LEDs on the receive and transmit modems (see 
Communicating with the Gateway through the serial port on 
page 95).

Table 12: Gateway LED cycling at startup

LED condition STATUS LED READY LED

Off Power off Power off or startup 
diagnostics not yet run 
successfully

Steady Green Normal operation Running software 
downloaded from NOC; 
successfully 
commissioned

Blinking Orange Contact between GWH 
and IRU over USB not 
established; USB cable 
not installed or some 
other USB problem

Not applicable

Blinking Green Not applicable Not commissioned

Steady Red Power on tests Not applicable
Appendix C • Installing the DW4020 Manually
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he receive and transmit modems have LEDs on their front 
anels. Both modems have a green READY LED. The receive 

modem has a green RX LED. The transmit modem has a green 
TX LED. The LEDs’ status indicate various conditions. Table 13 
describes the basic states.

The LEDs may also indicate various conditions through blink 
patterns. Tables 7 and 8 explain these. The numbers in brackets 
are the status codes discussed in The System Status indicator on 
page 36. 

If the modem does not appear to be functioning, check all cable 
connections. If they are secure, cycle the power by unplugging 
the power cord at the power supply and plugging it back in. A 
number of conditions and corrective actions are described below.

The READY LEDs should come on steadily when the DW4020 is 
powered up and when it is operating. The TX and RX lights can 
also blink when the DW4020 is first powered up, or when the 
DW4020 is power cycled. However, that blinking does not 
indicate anything about their status.
Table 13: Basic Receive and Transmit Modem LED States

Ready OFF/RX OFF Ready ON/RX Off Ready ON/RX 
blinking

Receive modem Modem not functioning Modem functioning, no 
data being received

Modem functioning, 
data being received

Ready OFF/TX OFF Ready ON/TX Off Ready ON/TX blinking

Transmit modem Modem not functioning Modem functioning, no 
data being transmitted

Modem functioning, 
data being transmitted
The DW4020 is extremely reliable. If you find you cannot surf 
the Internet or the DW4020 seems to have a problem, follow this 
sequence of steps below to identify and fix the problem.

• Check whether the DW4020 LEDs or on or off. The LEDs 
may indicate that a connection has become loose. 
Reconnecting a cable or power cord may restore function. 
See DW4020 LEDs status.

• Check if the LEDs are blinking in a pattern. The LEDs can 
blink in a pattern. The patterns correspond to the receive and 
transmit status codes discussed in Transmit Status messages 
on page 37 and Receive Status messages on page 42. See 
LED blinking indicating status codes on page 60 for a 
discussion of the blinking LEDs.
 Manually
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• Check if the LEDs on the back of the Gateway or on or off. 
The LAN ports on the back of the Gateway have LEDs. See 
Ethernet port LEDs on page 94.

• Contact Customer Care. If the corrective actions described in 
this chapter and Chapter 3 – The User Interface do not solve 
the problem, contact technical support.
The DW4020 LEDs T
m

he receive modem has a RX and a READY LED. The transmit 
odem has a TX and a READY LED. The Gateway has a 

STATUS and READY LED.

Note: Whenever the LEDs do not function properly as described 
below, check to be sure you have the correct power supply, PN 
1031105-0001.
DW4020 LEDs status T
D

his section describes the LEDs’ appearance during typical 
W4020 operation. It also describes their appearance when some 

basic problem is occurring.
Normal operation, no
transmit or receive

W
t
R

hen the DW4020 is powered on but not receiving or 
ransmitting data, it appears as shown in Figure 63. The modems’ 
EADY LEDs are continuously lit. Both the Gateway LEDs are 

continuously lit.
Figure 63: DW4020 normal operation, no data received or transmitted

Modems’ READY 
LEDs continuously lit

Both Gateway LEDs 
continuously lit
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uring normal DW4020 operation, the modems’ READY LEDs 
re continuously lit, the RX and TX LEDs blink as they pass data, 
nd both the Gateway LEDs are continuously lit, as shown in 

Figure 64.
Figure 64: Normal operation, data being sent and received

RX LED blinks as 
modem passes 
data; READY 
LED on 
continuously

TX LED blinks as 
modem passes 
data; READY 
LED on 
continuously

Gateway STATUS 
and READY LEDs 
continuously lit
Problem: receive modem
READY LED not on

I
m
f

f the DW4020 is not operating normally and the receive 
odem’s READY LED is not lit, as shown in Figure 65, take the 

ollowing steps:

• Check to make sure the power cord is securely attached to the 
receive modem and plugged into the wall outlet or surge 
protector. See Figure 66. If the power cord was loose, the 
receive modem READY led will come on when power is 
restored.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Receive modem READY LED still does not come on, 
power cycle the DW4020 by unplugging the power cord from 
the wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Note: Often, if the receive modem READY LED is not lit, the 
other modem LEDs will not be lit either.
 Manually
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Figure 65: Receive modem READY LED not lit

Figure 66: DW4020 power and cable connections

Receive modem READY LED 
not lit. Note that in many 
cases other modem LEDs 
will not be lit either.
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f the transmit modem is not operating normally and its READY 
ED is not lit, as shown in Figure 67, take the following steps.

• Check that the receive modem READY LED is continuously 
lit. If not, try the sequence in Problem: receive modem 
READY LED not on on page 88.

• Check that the 25-pin connector is attached securely. See 
Figure 66.

• Check to make sure the power cord is securely attached to the 
receive modem and plugged into the wall outlet or surge 
protector. See Figure 66. If the power cord was loose, the 
transmit modem READY led may come on.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the transmit modem READY LED still does not come on, 
power cycle the DW4020 by unplugging the power cord from 
the wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Figure 67: Transmit modem READY LED not lit

Receive modem READY LED 
continuously lit, showing that it is 
functioning

Transmit modem READY LED 
not lit
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f the Gateway does not seem to be functioning and its LEDs are 
ot lit, and the receive modem READY LED blinks as shown in 

Figure 68, take the following steps.

• Check to make sure the power cord is securely attached to the 
Gateway and receive modem and plugged into the wall outlet 
or surge protector. See Figure 66. If the power cord was 
loose, the Gateway and receive modem READY LEDs will 
come on when power is restored.

• If securing the power cord does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Gateway READY LED still does not come on, power 
cycle the DW4020 by unplugging the power cord from the 
wall outlet or surge protector, waiting ten seconds, and 
plugging it back in.

• If the problem persists, contact technical support.
Figure 68: Gateway LEDs not lit

Receive modem READY 
LED blinks

Gateway LEDS are 
not lit
Appendix C • Installing the DW4020 Manually
1031484-0001 Revision 2 91

Www.Somanuals.com. All Manuals Search And Download.



92
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f the Gateway does not seem to be functioning and its STATUS 
ED flashes amber, and the receive modem READY LED blinks 
r is not lit, as shown in Figure 68, take the following steps.

• Check to make sure the USB cable is securely attached to the 
Gateway and receive modem. See Figure 66. If the cable was 
loose, the Gateway and receive modem READY LEDs will 
come on when it is reattached.

• If securing the USB cable does not solve the problem, check 
all cable connections. Tighten any that seem loose.

• If the Gateway STATUS LED still does not come on 
continuously, power cycle the DW4020 by unplugging the 
power cord from the wall outlet or surge protector, waiting 
ten seconds, and plugging it back in.

• If the problem persists, contact technical support.
Figure 69: Gateway STATUS LED blinks amber

Receive modem READY 
LED blinks or is not lit

Gateway STATIS LED 
blinks amber
LED blinking indicating
status codes

T
p
T

he DW4020 modems’ READY LEDs can blink in various 
atterns. These patterns correlate to the status codes discussed in 
ransmit Status messages on page 37 and Receive Status 

messages on page 42. If you can see the patterns, you also have 
access to the User Interface. It will be easier to find out what the 
status of the DW4020 is via the interface than the LED status 
 Manually
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blinking. The blink patterns are described below for your 
information.
he 

e 
Transmit 
READY LED 

Pattern

Corresponding transmit status messages

Off 4 (or powered off)

On 8

2 Long,
1 Short

1

2 Long,
2 Short

2

2 Long,
3 Short

11

1 Long,
1 Short

3

1 Short 5

2 Short 10, 13, 14, 15,16, 21, 22, 23

3 Short 6, 7

4 Short 12, 17

Slow
Alternating

9,18,19,20

Fast
Alternating

The ITU interface testing – This is a continuous fast blinking pattern, with the Transmit LED being t
inverse of the Ready LED. No corresponding message.

Receive 
EADY LED 
Pattern

Corresponding receive status message

st
ternating

Prior to downloading software– This is a continuous fast-blinking pattern, with the RX LED being the invers
of the Ready LED. No corresponding message.

ow
ternating

 1

5

ong,
hort

3,6

ong,
hort

4,7

hort 0

ong,
hort,
ong

2

Table 14: Receive modem READY LED blink patterns
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ach of the four Ethernet ports on the DW4020 has two LEDs 
ssociated with it. One LED is green and one is yellow. See 

Figure 70.

The green LED will be on if power is applied to the DW4020 and 
a 100baseT Ethernet device is connected to the corresponding 
Ethernet port. Otherwise, the green LED will be off.

if the power is on and the light is off while a network device is 
connected, then the device is a 10baseT device and the port is 
autosensing.

The yellow LED will also be on when power is applied to the 
DW4020. It will flash momentarily when there is LAN activity 
on the corresponding Ethernet port.
Figure 70: Ethernet port LEDs

Green LED Yellow LED
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fter the Gateway finishes the LED sequence, you will use a 
aptop PC to communicate with the Gateway via a serial cable. 
You can also use a desktop PC.) You access the Boot Parameters 
creen and set the parameters. You also point and cross-pol the 

antenna. In order to complete the parameters, you will need your 
installer ID and the information shown in Figure 80 on page 102.
Connecting the Gateway
and laptop
1. Attach one end of a 9-pin F-F (female/female) null modem 
serial cable to the serial port on your PC. 

2. Attach the other end of the cable to the Gateway serial port 
(see Figure 71).

Figure 71: Location of Gateway serial port

Gateway serial 
port
Configuring Hyperterminal
or terminal emulation

program
3. Run Hyperterminal or a similar terminal emulation program 
to access the Gateway software Main Menu. The first time 
you do this, you configure the COM1 port’s properties and 
save the connection as a Hyperterminal.ht file. For all 
subsequent installs, you simply open the file.
Note: You can often find the Hyperterminal icon in the 
Accessories subfolder in the Windows Start menu. If you cannot 
find it there, go to Start→Find→Files or Folders and search for 
Hyperterminal. Windows will find the Hyperterminal folder. Open 
it and click on Hyperterminal. The program will run. If 
Windows does not find Hyperterminal you must install it. Go to 
Control Panel→Add/Remove Programs→ Add/Remove 
Programs Properties and select the tab for the version of 
Windows you use. Click the Communications checkbox. Click 
Details to make sure the Hyperterminal checkbox is checked; if 
it is not, check it and click OK. Click OK in the Add/Remove 
Programs Properties box. Windows should install Hyperterminal.
Appendix C • Installing the DW
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a. Select Start→Accessories→Hyperterminal and click on the 
Hyperterminal file (see Figure 72). The Connection 
Description window appears (see Figure 73). The red and 
yellow phones icon is highlighted in blue. You will 
establish a new connection.
Figure 72: Starting Hyperterminal
Figure 73: Connection Description window
 Manually
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b. Enter DW4020 in the New field.
c. Select OK. The Connect To window appears.
d. Select COM1 from the Connect Using pull-down list (see 

Figure 74). (Select COM2 is you want to use that port.)
Figure 74: Connect To window
e. Select OK. The COM1 Parameters window appears.
f. Configure the Port Settings by selecting the parameters 

below from the appropriate pull-down list (see Figure 75).
– Bits per second (baud): 9600
– Data bits: 8
– Parity: none
– Stop bits: 1
– Flow control: none
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Figure 75: COM1 Properties window and pull-down menus
g. Select OK. The window disappears.
h. Select File→Save As. The Save As window appears.
i. Enter DW4020 in the File name field and select Save. The 

window disappears. Now you will simply be able to select 
the DW4020.ht file when connecting the Gateway and the 
laptop during future installs.

j. Select Call→Connect. The laptop will connect to the 
Gateway.
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4. Press ENTER at the Hyperterminal prompt to display the 
initial Install Console screen shown in Figure 76. 

Figure 76: Initial Install Console screen
Note: For all future Gateway installations, use the DW4020.ht 
file you saved to connect the Gateway and laptop. Start 
Hyperterminal. Select File→Open→DW4020.ht. The Gateway 
and laptop will connect.
5. Press ENTER to display the Main Menu shown in 
Figure 77.

Main Menu:
  (a)  Configure Boot Parameters
  (b)  Display Current Configuration
  (c)  Display Satellite Interface Statistics
  (d)  Display Active Routing Table
  (f)  Run Software Download Monitor
  (h)  Display Reset History
  (i)  Installation

  (t)  Run Final/Built-in Tests

  (pc) (Parameter Clear)     Clear Configuration
  (pw) (Parameter Write)     Write Configuration
  (rr) (Gateway Reset)       Reset the Gateway
  (rd) (Gateway Deconfigure) Force Download and 
Acquire New Keys

Figure 77: BOOT ROM installer console Main Menu
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6. Enter c to display the Satellite Interface Statistics menu 
(see Figure 78).

7. Enter c to display the satellite interface serial number (see 
Figure 78).
If the electronic serial number is different from the barcode 
receive modem serial number, call the installer hotline for the 
DW4020 series and request the serial number be corrected. 
You must supply the Site/Master account number that can be 
found on the work order. Also observe all cautions in the 
Caution box below.

8. Enter Z to return to the Main Menu.

Figure 78: Satellite Interface Statistics menu with Display 
Satellite Interface Serial Number displayed
CAUTION
• You must confirm the receive modem electronic serial 

number through the serial connection using 
Hyperterminal when configuring the DW4020.

• If the electronic serial number is different from the 
barcode receive modem serial number, call the installer 
hotline for the DW4020 series and request the serial 
number be corrected. You must supply the Site/Master 
account number that can be found on the work order.

• Do not use any other receive modem at the site unless 
instructed by HNS personnel. If the wrong modem is 
brought to the pre-configured site, delays can occur due 
to re-configuration issues in the NOC.
 Manually
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se Configure Boot Parameters to configure the Gateway for 
utroute reception and downloading of software. For initial 
nstallation, most parameters must be entered, except for VSAT 

Return Path, which is always “Inroute.” 

Thus, you will need your installer ID, and you will need all 
necessary information to enter data for the fields marked with an 
asterisk in Figure 80. One asterisk means the installer must 
provide or obtain the information; two asterisks means the 
information is global for all installations. Refer to Appendix A 
for information on how to determine how to convert 
degrees/decimal values to degree/minutes values.
Note: Two good Web sites for determining your latitude and 
longitude include: http://www.zipinfo.com/search/zipcode.htm 
and http://www.census.gov/cgi-bin/gazetteer

Note: If you will be using the Outdoor Pointing Interface (OPI) 
device, remember that the LNB 22KHz Switch parameter must be 
set to "OFF" to enable the device. You may leave the parameter at 
OFF for the rest of the installation. The instructions below 
describe how to set parameters.
1. Enter a at the Main Menu prompt. Each parameter shown in 
Figure 80 appears, one at a time, one line at a time. 
For example, the first parameter to appear after you enter a is 
the VSAT Return Path Parameter, as shown in Figure 79.

.

VSAT Return Path (1 = Receive Only, 2 = Inroute, 3 = LAN) <2>:

Figure 79: VSAT Return Path Parameter
All the parameters are shown in the Display Current 
Configuration screen in Figure 80. The screen is displayed by 
entering b at the Main Menu prompt.                                                         
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Creation Date:                           Feb  8 2002, 11:43:08
Current Gateway Image Executing:         Main.bin
IRU Software Version Number:             33
=======================================================================
Parameter                                Value entered     Value in use
--------------------------------------   --------------    ------------
VSAT Return Path:                        **Inroute           Inroute
Satellite Longitude in degrees:          **117               117
Satellite Longitude in minutes:          **0                 0
Satellite Hemisphere:                    **West              West
VSAT Longitude in degrees:               *77                77
VSAT Longitude in minutes:               *10                10
VSAT Longitude Hemisphere:               *West              West
VSAT Latitude in degrees:                *39                39
VSAT Latitude in minutes:                *10                10
VSAT Latitude Hemisphere:                *North             North
Satellite Channel Frequency:             *11100 (x 100Khz)  11100 (x 100Khz)
Receive Symbol Rate:                     *30000000 Sps      30000000 Sps
LNB Polarization:                        *Vertical          Vertical
LNB 22KHz Switch:                        *On                On
Filter Rolloff:                          *20                20
LAN1 IP Address:                         *66.82.56.50       66.82.56.50
LAN1 Subnet Mask:                        *255.255.255.240   255.255.255.240
IP Gateway IP Address:                   *66.82.24.154      66.82.24.154
SDL Control Channel Multicast Address:   *224.0.1.4         224.0.1.4
VSAT Management IP Address:              *10.0.0.0          10.0.0.0
Default Router IP Address:               10.0.0.10         10.0.0.0
Main Menu (<?/CR> for options):

Figure 80: Display Current Configuration Screen 
2. As each one-line parameter appears, enter the specific values 
as defined in the installation specification for this customer or 
as specified by HNS personnel and press ENTER. The next 
parameter will then appear. 

Type - and press ENTER at the prompt to go to the previous 
parameter. You can also skip the remaining parameters by 
typing \ and pressing ENTER.
Note: The Default Router Address isn’t used in most cases 
and doesn’t have to be configured. The VSAT Return Path 
should be configured to "Inroute."

Note: The values in the examples are for illustrative 
purposes only. Do not use them to configure the Gateway.
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3. When you have entered all parameters, return to the Main 
Menu and enter pw. This saves the configuration parameters 
to the flash memory. At this point, depending on the 
parameters that were modified, the Gateway may reset. 

4. A message Writing the configuration -are you 
sure (y/n) appears.   Enter y. At this point, depending on 
the parameters that were modified, the Gateway should reset. 
If it does not reset, enter rr to do a Gateway reset.

5. At the Main Menu prompt, enter b to display the current 
configuration. The display is similar to the one shown in 
Figure 80. Verify the parameter values and match them to the 
installation or NOC specification.
The Installation Menu A
fter you have entered the boot parameters, use the Installation 
Menu to receive and transmit point the antenna. Transmit 
pointing uses both an automatic and manual mode.

The Outdoor Pointing Interface (OPI) device can also be used to 
point an antenna used with a DW4020. Follow the instructions in 
the Outdoor Pointing Interface Operating Instructions (HNS 
1031832-0001).
Note: Remember that if you use the OPI, the LNB 22KHz 
Switch parameter must be set to "OFF." You may leave the 
parameter set at "OFF" for the rest of the installation.

Note: Remember that if you wish to exit the Installation Menu 
and return to the Main Menu, you must type "Z" and press 
ENTER. If you don’t you’ll remain in one of the Installation 
submenus until you do so.
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CAUTION
• The two-way satellite dish assembly emits radio 

frequency energy when in the transmit mode.
• Unplug indoor power connection before performing 

maintenance or adding upgrades to any satellite dish 
components.

• To avoid risk of injury, do not place head or other body 
parts between feed horn and reflector when system is 
operational.

�����0���&�����
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Antenna Pointing - Receiver T
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his section describes how to verify adequate receive signal 
reception, that is, with a signal quality factor (SQF) of over 30.

1. Enter i at the Main Menu prompt. The Installation Menu 
appears (see Figure 81). Enter either your installer ID number 
or <CR>, which defaults to a valid installer ID, to access the 
submenus. If automatic cross-polarization (ACP) is not 
available, "Transmitter, Automatic (not 
available" will appear in the menu.  
Installation Menu:
  (a) Antenna Pointing - Receiver
  (b) Antenna Pointing - Transmitter, Automatic
  (c) Antenna Pointing - Transmitter, Manual
  (d) Verify Ranging
  (z) Return to Main Menu

Figure 81: Installation Menu
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2. At the Installation Menu prompt, enter a to obtain antenna 
pointing values and assigned satellite parameters. The 
Antenna Pointing - Receiver screen in Figure 82 appears.
Figure 82: Antenna Pointing - Receiver
The SQF represents the strength of the received signal 
relative to noise. SQF is an integer value between 0 and 99. 
The SQF value is interpreted as follows:
– 0-29. The receive modem is not locked onto the desired 

signal. The value increases as the Gateway receives 
stronger signal power.

– 31-99. The receive modem is locked onto the desired 
satellite signal.

– 30. The receive modem is locked onto a satellite signal, but 
is waiting for a message confirming that it is locked to the 
correct signal. An unchangeable value of 30 indicates that 
the receive modem is locked onto a wrong signal.

3. If the SQF is less than 30, refine the antenna pointing to bring 
the SQF over 40 and to as close to 99 as possible. The SQF 
message updates automatically. There is a delay of up to 10 
seconds between the displayed and the current SQF value.

4. If you cannot achieve a satisfactory SQF, take the steps below 
in the order suggested until the situation is corrected.
a. Check for unobstructed view to the satellite.
b. Refine antenna aiming.
c. Check LNB polarization.
d. Check receive symbol rate.
e. Replace LNB.
f. Replace entire DW4020 unit.
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he manual cross-polarization function can be used to adjust the 
ntenna and peak the antenna’s transmit polarization for 

maximum isolation. You can also use manual pointing to adjust 
polarization after failing the automatic cross-polarization test.

1. Enter C at the Installation Menu prompt. The Antenna 
Pointing - Transmitter, Manual screen appears. 
Otherwise, the screen shows the current queue position until 
the test can be run. When the Test Status field shows Active 
the test can be run. The result of the test is shown in the 
Result: field, where a transmitter isolation value is reported. 

2. Make small, one-degree or less changes in polarization while 
observing the transmitter isolation. Peak the transmitter to the 
highest possible transmitter isolation value.

3. Press Enter to return to the Installation Menu.
Antenna Pointing - Transmitter,
Automatic
Automatic cross-polarization (ACP) is used for a rapid Pass/Fail 
test of the antenna’s transmit polarization adjustment. If you pass 
ACP the unit is enabled and no further antenna pointing is 
needed. 

1. Enter B at the Installation Menu prompt. The Antenna 
Pointing - Transmitter, Automatic screen appears. 
Otherwise, the screen shows your current queue position until 
the test can be run. (Sometimes a number of installers will be 
pointing their antennas at the same time. You may have to 
wait for the test to be run, and are placed in a queue until it 
can be run.)
The result of the test is shown in the Result: field. PASS 
means the transmit modem will be enabled and the system 
should be operational. FAIL means the transmit modem will 
be disabled and the dish pointing needs to be checked.

2. Whether you pass or fail, press Enter to return to the 
Installation Menu.

3. Enter z to return to the Main Menu.
4. At the Main Menu enter c. The Satellite Interface Statistics 

Menu appears (see Figure 83).
5. Enter a. The Display Main Statistics screen appears. Confirm 

the SQF is greater than 31 and that the transmitter is 
available.

6. Enter z to return to the Main Menu.
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CAUTION
Any time you enter the DW4020 Installation Menu, the 
transmitter is turned off for safety reasons. Do not enter "I" 
to access the Installation Menu after this point unless 
instructed to do so by a technician at the NOC.
Figure 83: Display Main Statistics
Range value
 Ranging may have to be initiated by the NOC to adjust for 
differences in delay due to distance to the satellite. Check your 
installation specification to see if this is necessary.

To learn if ranging is available and being used by the unit, enter d. 
If it is available and used, SUCESSFUL will appear; if not, NEED 
RANGING will appear.

Ranging must be done before you exit the Installation Menu.
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f the Gateway is configured correctly for outroute reception and 
QF is greater than 30, it will acquire the outroute. As soon as the 
ateway acquires the outroute, it begins to look for the Hub 

Server in the data stream to perform software download.

1. To monitor software download (SDL) progress, enter f at the 
Main Menu prompt to select Software Download Monitor.

2. The following message is displayed at the bottom of the 
screen:
SDL Initialization complete. Awaiting first heartbeat msg.
This message is dynamically updated. It indicates that SDL 

has started and is waiting to connect with the hub server.
Note: It may be 20 minutes before the first heartbeat message is 
received.
3. If SDL does not progress beyond this message, check the 
following:

• The SDL control channel’s multicast IP address
– Return to the Main Menu.
– Enter b to view the current configuration
– Check that the SDL Control Channel Multicast Address is 

correct. If not, enter the correct address.
• The Ready lights to ensure they are on. See The DW4020 

LEDs on page 86 and Communicating with the Gateway 
through the serial port on page 95.

4. When the Gateway receives a message from the Hub Server, 
the following message is displayed:
Received first heartbeat message.

5. If there is no progress beyond this message, check the return 

path. When operating normally, the following message is 
displayed:
Received File/Group message. Reconciling files...
MM loading...
IP loading...
...
All files downloaded. Notifying CFM.
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6. On successful download, the Gateway automatically resets to 
reflect the new software. The new configuration takes effect.

7. At the Main Menu prompt, select f to monitor SDL progress. 
The following messages are displayed:

Figure 84: Gateway reset
SDL Initialization complete. Awaiting first heartbeat msg.
Received first heartbeat message.
All files downloaded. No pending changes.
The DW4020 may now be hooked up to either a configured PC or 
network.
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he DW4020 has no serviceable parts. However, you may be able 
o debug units with help from the network operations center 
NOC). You access the menus below via the serial port, just as 
hen you set up the DW4020.
Verifying correct 
DW4020 operation

Y
d

ou can verify that the DW4020 unit is receiving and processing 
ata by following the steps given below.

1. Enter A at the Main Menu to access Satellite Interface 
Statistics. 

2. At the Satellite Interface Stats submenu enter A to select 
Display Main Statistics. In the display that appears (see 
Figure 85), check if frames are being accepted.
Signal Quality Factor:   <83>
    Frames Received:         <181>
    F-error:                 <0>
    Addresses Open:          <2>
    Receive Status:          <The receiver is operational.  (RxCode 5)>
    Transmit Status:         <The transmitter is available.  (TxCode 8)

Figure 85: Display Main Statistics
The Frames Received and F-error values indicate the 
DW4020 is detecting frames and correctly receiving and 
demodulating an outroute signal. 
Note the Signal Quality Factor is also reported; if the SQF is 
below 31, the antenna must be repointed.
The Receive Status and Transmit Status fields report whether 
the receive and transmit modems are operational. If they are 
not operational or available, antenna pointing is not possible.

The Rx and Tx codes have the same meanings as explained in the 
LED flashing code tables above.
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t the Satellite Interface Statistics submenu enter B to select 
isplay Traffic Statistics. The screen in Figure 86 appears.
aam info
---------------------------------------------------------
state              dpcmac   ethmac       key
------------------ -------- ------------ ----------------
ADDR_RESERVED  (4) 5E6EEFEF 01005E6EEFEF 0000000000000000
ADDR_UNICAST   (8) 0A0B36E3 02000A0B36E3 DFCFA55F949BA608
ADDR_CLOSED    (5) 5E000104 01005E000104 0000000000000000
MacAdrs      RxOk       RxCrc      RxLost     BadKey
------------ ---------- ---------- ---------- ----------
000000000000 0000000000 0000000000 0000000000 0000000000
02000A0B36E3 0000000171 0000000000 0000000000 0000000000
01005E6EEFEF 0000000012 0000000000 0000000000 0000000000
030001000009 0000007651 0000000000 0000000000 0000000000
030001020000 0000000476 0000000000 0000000000 0000000000
030001010000 0000001419 0000000000 0000000000 0000000000

Figure 86: Display Traffic Statistics screen
Displaying PEP statistics T
I

o check performance enhancing proxy (PEP), at the Satellite 
nterface Statistics submenu enter G to select Display PEP 

Statistics. The screen in Figure 87 appears. 
 TCP Spoofing Flag          :Disabled
    Rx PBP                     :3
    Rx PBP Bad Checksum        :0
    Tx PBP                     :0
    Rx TCP                     :0
    Rx TCP Bad Checksum        :0
    Rx TCP Spoofed             :0
    Rx TCP SYN Unspoofed       :0
    Rx TCP Unspoofed           :0

    Priority                   1          2          3          4
    PBP Status                Closed     Closed      Closed      Closed
    PBP Rx Pkts                0          0          0          0
    PBP Tx Pkts                0          0          0          0
    PBP Rx SACK                0          0          0          0
    PBP Tx SACK                0          0          0          0
    PBP Rx RST                 0          0          0          0
    PBP Tx RST                 0          0          0          0
    PBP Snd/Rcv Win           0/   0     0/   0      0/   0     0/   0
    W2L limit/curr            0/   0     0/   0      0/   0     0/   0
    L2W limit/curr            0/   0     0/   0      0/   0     0/   0

Figure 87: Display PEP Statistics screen
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he Final Test Menu is not used by installers. It is used at the 
actory to ensure the various DW4020 components are functional. 

The menu is shown below.

Final Test Menu:
  (a) LED Test Pattern
  (b) Ethernet Ports Test
  (c) Modem Signal Test
  (d) USB Port Test
  (g) Factory Information Read
  (z) Return to Main Menu

Figure 88: Final Test Menu
Other options T
his section describes some other options in the Main Menu.
Display active routing table
 Menu Option (d) displays the current data in the Active 
Routing Table, shown in Figure 89. This data is read-only.

Main Menu (<?/CR> for options): d

Active Routing Table:
Entry   Destination Network   Gateway Address   
Subnet Mask

Main Menu (<?/CR> for options):

Figure 89: Active Routing Table display
Reset history M
enu Option (h) displays the reset history for the DW4020 as 
shown in Figure 90. One of the most recent 8 reset logs may be 
displayed. Index 0 is the most recently logged reset.
Time of Reset :         THU JAN 01 05:47:35 1970
Asserted at   :         t=tInterface ../../../source/sd/cim.c#1918:
Reset Type    :         Valid Software Reset
Reset Reason  :         Manual reboot via Install Console rr command

Figure 90: Reset history
This data is read-only.

Note that you reset the DW4020 by typing rr at the Main Menu 
prompt and pressing Enter. You can force the DW4020 to 
download new software keys by typing rd and pressing Enter.

Reading factory information

Option (g) displays read-only information from the manufacturer. 
This option automatically returns to the Final Test menu.
 Manually
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Appendix D
Configuring the installer laptop for IP
addressing
This chapter explains how to configure your installer laptop PC 
so that you can register the DW4020. All DW4020s come from 
the factory with Dynamic Host Configuration Protocol (DHCP) 
enabled.  Therefore, your installer laptop PC must have DHCP 
enabled and set to automatically obtain IP addresses..
Windows 98SE and ME
 1. On the client computer, go to Start→Settings→Control Panel 
and double-click Network. See Figure 91.

Note: On Windows ME computers, choose View All Control 
Panel Options to see the Network icon.
2. A list of network components will be displayed. See 

Figure 92.
Figure 91: Control Panel
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Figure 92: Network window
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3. Select the TCP/IP entry associated with Network Interface 
Card (NIC) and then select Properties. The TCP/IP 
Properties window appears. See Figure 93.

4. In the IP Address tab, select Obtain an IP address 
automatically.

5. Select the Gateway tab. Remove any installed gateways by 
selecting them and selecting Remove. See Figure 94.

6. Select the Disable DNS radio button on the DNS 
Configuration tab.

7. Select OK to accept the updates for the TCP/IP properties
ler laptop for IP addressing
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8. Select OK to close the list of network components. Windows 
may request the installation CD-ROM to complete updating 
the TCP/IP settings.

9. Restart the computer if it does not do so automatically.
Figure 93: TCP/IP Properties

Figure 94: Gateway tab
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Windows 2000
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1. On the client computer, go to Start→Settings→Control Panel 
and double-click Network and Dial-up Connections.

2. A list of network adapters appears. See Figure 95. The Local 
Area Connection adapter must be listed. If it is not, the 
network is not installed correctly.

3. Right-click the Local Area Connection icon that represents 
the network adapter that connects the computer to the 
DW4020 and select Properties. The Local Area Connections 
Properties window appears. See Figure 96.

4. Ensure that the Client for Microsoft Networks and Internet 
Protocol (TCP/IP) are installed and checked. If NetBEUI is 
installed, uninstall it.
Figure 95: Network and Dial-up Connections

Figure 96: Local Area Connection Properties
ler laptop for IP addressing
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5. Select Internet Protocol (TCP/IP). Be careful not to uncheck 
the checkbox.

6. Select the Properties button. The Internet Protocol Properties 
window appears. See Figure 97.

7. Ensure that both Obtain an IP Address Automatically and 
Obtain DNS Server Address Automatically are selected. If 
not, select them.

8. Select OK to close the open dialog boxes and finish the 
configuration.

9. Restart the computer even if Windows does not require you to 
do so. This will ensure that the network settings are 
automatically reset.
Figure 97: Internet Protocol Properties
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Windows XP
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1. Go to Start→Settings→Control Panel. Double-click the 
Network and Dial-up Connections icon.

Note: If the Control Panel is in category view select Network and 
Internet Connections then select Network Connections.
2. A list of network adapters will be displayed. A Local Area 

Connection must be listed under LAN or High-Speed 
Internet. If not, the network is not installed correctly. See 
Figure 98.

3. Right-click the Local Area Connection icon that represents 
the Network adapter that connects the computer to the 
Satellite Gateway and select Properties.

Note: If the Local Area Connection icon appears with a red X 
then check your connections. The red X must not be present in 
order for you to be successful.
4. Ensure that the Client for Microsoft Networks and Internet 

Protocol (TCP/IP) are installed and checked. If NetBEUI is 
installed, uninstall it. See Figure 99.

5. Select Internet Protocol (TCP/IP) and select Properties. See 
Figure 100.

Note: Be careful not to uncheck the Internet Protocol when you 
select it
6. Ensure that both Obtain an IP address automatically and 

Obtain DNS server address automatically options are 
selected. If not, select them.

7. Select OK to close the open dialog boxes and finish the 
configuration.

Restart the computer even if Windows does not require you to do 
so to ensure that the network settings are automatically reset.
Figure 98: Network Connections
ler laptop for IP addressing
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Figure 99: Local Area Connection Properties

Figure 100: Internet Protocol Properties
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Appendix E
Installation checklist
Installation summary 
and checklist

T
he following DW4020 components are installed:

• Antennas (outdoor unit or ODU)
• Coaxial cable (IFL)
• DW4020

The main tasks required to install an DW4020 are summarized 
below. For Web commissioning, the customer should have an 
analog phone line and a functioning Ethernet interface.
Assemble the DW4020 components. These consist of the receive and transmit 
modems, and the Gateway.

Connect the DW4020 to installer laptop PC Ethernet and power up DW4020.

Connect the installer laptop PC via USB and run Websetup to establish operating 
parameters.

Register the end user and select subscription options via Websetup.

Record site ID, Gateway IP address, subnet mask, and service offering on cover 
of User Guide. 

Transfer of parameter information to Gateway. Exit Websetup. 

Assemble and install the satellite antenna. Run cables from the outdoor components 
to the indoor equipment. Clearly label the receive and transmit coaxial cable at the 
antenna, ground block, and modem connectors.

Complete antenna pointing and auto cross-polarization (ACP).

Disconnect installer laptop PC and connect the Gateway to the receive modem 
with USB cable. Connect the customer computer to the Gateway via Ethernet 
cable.

Verify customer operation, information recorded on User Guide cover, and 
receive and transmit cable labeling. Optional: assist in customer computer 
configuration.
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